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Preface 
 
Thank you for purchasing the TOPCON ScanMaster. To get the best use of the instrument, read 
carefully the On-line Instruction Manual of this software. 
 
Copyright Statement 
This software is copyrighted by TOPCON, and the specifications are subject to change without prior 
notice. 
This manual is copyrighted by TOPCON. It is not allowed to copy or reprint contents of this manual 
in whole or in part without prior approval. The contents are subject to change without prior notice. 
Contents of this manual are prepared with thorough care. However, your information about 
incomprehensibilities and errors, if any, would be highly appreciated. 
 
Trademarks 
Microsoft Windows is the registered mark or trademark of US Microsoft Corporation. 
Pentium is the registered mark or trademark of US Intel Corporation. 
Other company names and product names stated herein are the registered mark or trademark of each 
company. 

Contains Autodesk®RealDWG by Autodesk, Inc., 

CopyrightⒸ 1998-2006 Autodesk, Inc. All rights reserved. 
Portions of this software are owned by Octree CorporationⒸ 1986-2009 
 
Disclaimer 
TOPCON shall not take any responsibility for damage due to fire, earthquakes, actions by third 
persons, intension or fault of the user, misuse and use under unusual conditions. 
TOPCON shall not take any responsibility for damage due to inability to use this instrument, 
including change/loss of data, loss of business profit and suspension of business. 
TOPCON shall not take any responsibility for damage caused by operations other than those 
described in this Instruction Manual. 
TOPCON shall not take any responsibility for damage caused by malfunctions due to combination 

with other instruments. 
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Introduction 
 

ScanMaster is a PC-based laser scanner control and point cloud processing software. ScanMaster enables you to 
view, navigate, measure, and model data in 3D for a variety of surveying purposes. 
ScanMaster features include: 

•  GLS-1000 Scanner Control 
•  Image Control 
•  Point Cloud Registration 
•  Survey Annotation 
•  3D Shape Modeling 

This guide describes how to get started using ScanMaster and provides detailed steps for processing and 
customizing laser scan data. 

 

Installing ScanMaster 
ScanMaster is delivered to licensed users on a CD-ROM. The CD contains the software required to install 
ScanMaster on a computer running a Microsoft Windows® 2000, XP, or Vista operating system. 

To install ScanMaster on your computer for the first time, close any programs that are open on your computer, and 
then click the SETUP file on the CD. The setup wizard automatically appears. Follow the instructions on the 
wizard. When the installation is complete, the ScanMaster icon  appears on the computer desktop. To start 
ScanMaster, click this icon. 

System Requirements 
To determine if your computer can run the ScanMaster software, make sure it is compatible with the requirements 
listed inHardware Specifications. 

Table 1-1. Hardware Specifications 

Components Minimum Requirement 

Computer CPU Pentium processor, 1 GHz or higher 

RAM 1GB 

Operating System Windows 2000, XP, Vista 

USB Port USB 2.0 

Monitor 1024 x 768 res. 

Mouse Scroll wheel 
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Installation 
This chapter will explain the installation of the instrument and target sheet. 

 
As shown in the figure below, install the GLS-1000 and the target sheets (small), which are its accessories. 
Adhere the target sheets (small) on a wall, etc. 4m away from the instrument. 
Put one target sheet away from another by about 3m in the diagonal 45° direction.  Measure the distance between 
the two target sheets with a steel tape or the like and record the measured value. 
Then, scan each target sheet (small) with the GLS-1000 and measure the distance between the two points. 
Analyze the data in “Data Analysis”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4m 3m 

1m 

45° 1m 
A

B 

The personal computer 
to which ScanMaster is 
installed 

Target sheet (small)

Target sheet (small)

(Example) 3.005m 
The measured value by steel tape 

GLS-1000 
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Making the Work Spot 
Measure the distance with the GLS-1000 according to the following procedure, using ScanMaster. 
First, set the place to store the data acquired by the scanner. 

 
(1) Double-click the “Topcon ScanMaster” icon on the desktop. 
 
 
 
 
(2) After the application program has started, 

click “File” and then “New”. 
 
 
 
 
 
 
 
(3) Input the work spot name to “File Name:” and press the [Save] button. 

 
 
 
 
 

The work spot name is inputted.
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Acquiring the Data 
Acquire the data by controlling through ScanMaster. 

 

Connecting to GLS-1000 
(1) Start the GLS-1000. 
(2) After the GLS-1000 has started, connect it to a personal computer according to the following procedure. 

 
 
 
 
 
Press the                   button at the lower left  
corner on the screen, and the connection menu 
shown at the right appears. 
 

Select “USB” and press the [OK] button. 
After a while,                   is changed 
to           . 
When            is displayed, the connection is 
completed.  

 
 
 
 

Setting the Instrument Point 
Click the right mouse button for “Scan Positions”.  Then, click “Create Scan Position”. 

The instrument point “Scan Position 01” is made. 
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Measurement 
(1) Click “Device” at the lower right corner on the screen. 

 
(2) Place a check mark of “ON” for the screen area, and the image is displayed. 
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(3) Click “Create” on the toolbar and then click “Target Scans”.  The “Capture Target Scan” window is 
displayed. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
(4) Click the center of the target to be scanned (①). 

Then, press the button on the “Capture Target Scan” window. (②) 
Target scan starts. 

 
 
 
 
 
 

 
 
 2 

1 
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(5) Change the display method to “Target Scan”, and the scanned target is displayed as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(6) Scan another point as the target in the same way. 
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Data Analysis 
This chapter will explain the data analysis procedure. 
 
The point for which target scan has been done cannot be used for analysis because it is in the original condition.  
However, if the point is copied, the same coordinate can be acquired and you can analyze it. 

 
(1) Click the right mouse button for the point to be used and select “Create Tie Point”.  The target scan point is 

copied and it is named “Tie Point 01”.  Copy another point in the same way. 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
(2) Select “Cube” of the icon at the upper left corner on the screen so that the point can be seen clearly. 
 
 
 
 
 
 
 
(3) Click the “Objects” tab at the lower right 

corner on the screen. 
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(4) Click the right mouse button for “Distances”, which is under “Measurements” at the lower left corner on the 

screen, to select “Measure Distance”.  As pressing the [Ctrl] key, click the point to be measured. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A black arrow is displayed between the two points. 

 
 

2

1 
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(5) “Distance 01” is made under “Distance”.  Click and reverse “Distance 01”.  The arrow color is changed 
from black to yellow and the measurement results are displayed on “Object properties”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The value of “Slope” under “Measurement” is the distance between the two points. 
 
Compare this value with the value measured by the steel tape or the like.  If the difference between the values is  
6mm or less , the instrument is normal. 

 
Example) 

The value measured by steel tape 3.005m 
The slope value measured by GLS-1000 3.010m 

Difference 0.005m 
 

Result:  5mm<6mm (Allowable difference)  The instrument is normal. 
 
 
If you repeat measurement several times and the measurement result is beyond the above accuracy, contact 
TOPCON or your dealer. 
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Chapter1 
  Work Space 
ScanMaster provides an efficient work space and interface designed to make data processing quick and easy. The 
work space is divided into three main areas: 

•  Menu and Toolbar 
•  Windows 
•  Tables 

Menu and Toolbar 
The menu bar at the top of the window contains commands (operations). Some of the file menus have submenus 
containing related commands as shown inMenu Commands. 

Menu Bar

Submenu

Commands

 
Figure 2-1. Menu Commands 

Icons are displayed to the left of most menu commands, so you can easily identify the command on the toolbar for 
quick use. To display the name of the icon, roll over the icon with the pointer. 

 
Figure 2-2. Toolbars 

Customizing the Toolbar 
You can show or hide a toolbar by clicking View Toolbars. In the Toolbars submenu, a check mark next to a 
toolbar name indicates the toolbar is displayed. To hide a toolbar, click to clear the check mark. 

To reposition a toolbar: 
1.  Click on the left side of the toolbar, not on an icon. 

The pointer changes into the Move  pointer. 
2.  Drag the toolbar to another location or in the Viewer Window.  
3.  To create a vertical toolbar, drag the toolbar to the edge of the window. 
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To add or remove icons from a toolbar, click on the small black arrow at the end of each toolbar and select an icon 
to remove as shown inToolbars - Add and Remove Option . 

 
Figure 2-3. Toolbars - Add and Remove Option 

Shortcut Menus 
The shortcut menu contains commands that apply to the currently selected object(s). If the selected objects are of 
different types, then only commands available for all of the selected object types are available. The options 
available in the shortcut menu vary according to the current activity. 

To use the shortcut menus, right-click on an object to open the shortcut menu and then select a command. For 
example, if you right-click on an annotation in the Project Explorer, then a menu of all available commands for 
the annotation appears. 

 
Figure 2-4. Shortcut Menu 

The commands available in the shortcut menu are also available in the Edit menu. 

Windows 
ScanMaster uses a convenient and flexible system of docking windows to present data: 
There are three basic types of windows in ScanMaster: 

•  Dialog Window  
•  Viewer Window   
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•  Chapter16 
Cross Sections 

 

Dialog Window 
The dialog window appears when certain commands are executed. For example, if you select the Resample 
command for a point cloud, the Resample Cloud dialog window appears. This window can be repositioned and 
stays on top of ScanMaster until you take action. 

 
Figure 2-5. Tool Window 

Viewer Window   
Viewer windows contain the graphics. They are organized into one or more viewer tabs in the central area of the 
screen. 

Viewer
Window

Viewer
Tabs

 
Figure 2-6. Viewer Window 

Viewer tabs are a group of viewer windows stacked on top of each other. To switch between viewer windows, 
click the tabs.  

Multiple Viewer Windows 
When registering data from two or more scan positions it is often better to look at data from two different views at 
the same time.  
To place a viewer window next to the current one:  
1.  Click on a specific viewer tab, and drag it into the viewer window.  

When you drag a tab into the viewer window, the Docking Selector appears, displaying these placement 
options: center, top, bottom, left, and right. 
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Top
Selector

Right
Selector

Center
SelectorBottom

Selector

Left
Selector

 
Figure 2-7. Docking Selector 

2.  Drag the tab onto one of the selectors to create a second view. Repeat this process as necessary. 

Current
Viewer Window

Second
Viewer Window  

Figure 2-8. Viewer Windows Side by Side 

3.  To move additional viewer tabs to the secondary viewer window, drag the tab onto the center Docking 
Selector. 

4.  To resize a window, move the pointer over the borderline between two adjacent windows until the pointer 
changes shape . Press and hold the left mouse button, drag the borderline to a new position, and then 
release the mouse button. 

You can create numerous viewer windows and arrange them how you want to; however, laser scan datasets are 
performance intensive regarding the CPU, graphical unit, and memory processing. To conserve system resources, 
it is best to close windows you are not using. 

 

Dockable Tool Windows  
Dockable windows, such as the Project Explorer, attach to the edge of a frame and are easily customized.  

There are three types of dockable windows: collapsed, docked, or floating. You can access a menu of dockable 
window types by: 

•  Right-clicking on the title bar of a floating window. 
•  Selecting the title bar of a window and then clicking on the Window menu. 
•  Clicking the drop-down arrow on the title bar of any docked window or table. 
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Figure 2-9. Window Positioning Menu 

Collapsed Window 
This is a docked window that disappears when it is not in use to save space. This window is represented by small 
tabs on the side of the screen. 

 
Figure 2-10. (Collapsed) Tabs 

To expand a docked window, move the pointer over the corresponding tab and the window automatically opens.  
When the Collapse icon appears on its side  in the title bar, this indicates the window or table is set to collapse. 
To change this setting, you can: 

•  Click the Collapse icon to turn it upright . 
•  Click the drop-down arrow and select Collapsed. See also Window Positioning Menu. 
•  Click Window Collapsed.  

Docked Window 
Docked windows are attached to the edge of a frame (top, bottom, left, or right) and are easily customized. 

Docked
Window

Docked
Window

 
Figure 2-11. Docked Windows 

If you click on the drop-down arrow in the window title bar, you’ll see the Window Positioning menu. 
You can stack the docked windows one above the other and next to each other. Using the docking selector, you 
can stack windows on top of each other and click the tabs to switch between windows. 
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These tabs indicate more
than one window. Click the
tabs to switch between
windows. The Options tab
is currently active.

 
Figure 2-12. Two Docked Windows - Project Explorer and Program Options 

Floating Window  
This is a window that floats on top of ScanMaster and can be freely repositioned by clicking on top of the title bar 
and dragging it or docking it. 

 
Figure 2-13. Floating Window 

Project Explorer Window 
The Project Explorer is a dockable window and displays a list of project objects, organized into folders by type 
and in tree view. Only object types with a graphical representation appear in this list.  

You can select objects from this list, so they appear highlighted in the viewer window, and you can also rename 
objects in the Project Explorer. 

To open the Project Explorer, click View Windows Project Explorer or click the Project Explorer  icon 
on the Standard toolbar. 

 
Figure 2-14. Project Explorer Window 
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Object Properties Window 
The Object Properties window enables you to view and edit the attributes and values of any object that is stored in 
a project. You can also use the Object Properties window to view and edit attributes from multiple objects at the 
same time and objects of different types, such as an annotation and a polyline. All of the values they have in 
common are displayed. Any value they don’t have in common will be unavailable.  
To open the Object Properties window: 

•  Select an object and then click Edit Properties. 
•  Click View Windows Object Properties. 
•  Click the Object Properties  icon on the Standard toolbar. 
•  Right-click on an object in the Project Explorer, and select Properties from the shortcut menu. 

 
Figure 2-15. Object Properties Window 

Program Options Window 
The Program Options (or preferences window) enables you to view and edit program appearances and 
performance options. The options are organized into folders. To edit an option, click on the option value and make 
a selection from the drop-down menu. For example, to change the color of the bounding cube, click on the current 
color and then select a new one from the color list that appears. See Program Options Window.  

To open the Program Options window, click Tools Options. If the Project Explorer and the Program Options 
windows are open, then you can switch between the two windows by clicking the appropriate tab at the bottom of 
the window. 

Click these tabs to
switch windows

Click on a value for
more options

 
Figure 2-16. Program Options Window 
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Windows Manager 
You can access the Windows manager by clicking Window Windows. The Windows manager displays the 
names of all of the open windows and tables. From the Windows manager, you can activate any individual 
window by selecting its name from the list and clicking Activate. You can also close windows from the manager 
by selecting a name and then clicking Close. 

 
Figure 2-17. Windows Manager 

Tables 
When an object or project folder is selected, you can open an object table. Object tables enable you to edit the 
attributes of an object. Because the content is listed in a spreadsheet format, you can easily export the information 
to another software program, such as Microsoft Excel®. See Exporting Data.  

Object Tables 
To open an object table for any object: 

1.  Select the object by doing one of the following: 
•  Clicking on the object in the Project Explorer. 
•  Click on the object in the Viewer Window by selecting Select Mode Objects and then Select Point. 

2.  Once the object is selected, click Edit Table. Or, if you selected the object using the Project Explorer, then 
you can right-click and choose Table from the shortcut menu. 
The object table opens in a spread sheet format that lists all of the objects of the same type in the project and 
editable attributes. 

 
Figure 2-18. Object Table 

3.  To dock the table, click on the table title bar and begin to move it. The docking selector appears.  
4.  Place the table on the left, right, top, or bottom arrow of the docking selector, depending on where you want to 

dock the table. 
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Figure 2-19.  Docked Object Table 

In most cases, opening the table for an individual object or the folder in which it is contained produces the same 
result. The only exception is when there is more than one folder with the same name inside the Project Explorer. 
In this case, opening the table for an individual object displays the objects in all of the folders that share the same 
name; however, if you opened the table for a folder that has the same name as other folders, only the objects in 
that folder are displayed. 

For example, you can have a folder named Tie Point for each scan position. If you opened a table for an individual 
tie point, then the table will display all of the points in all of the Tie Point folders for each scan position. 
Consequently, if you opened the table for an individual Tie Point folder, then the table displays only the tie points 
in that folder. 

Editing Object Tables 
Some of the things you can do with an object table is edit the attributes.  

•  To rename an attribute, click on the name you want to change and type a new name. ScanMaster updates the 
project to reflect the edit. 

•  To reorder the columns, do one of the following: 
•  Click on a column header and drag it to another location.  
•  Right-click on a column header, and select Table Properties. The Table Properties window appears. 

Up and Down
Arrows

 
Figure 2-20. Table Properties Window 

Select a column header, and then click the up or down arrow to move the header to a different location in 
the order. 

•  To show or hide a column header, open the table properties. (Right-click on the column header, and select 
Table Properties.) All of the headers with check marks are shown in the object table. 

•  To hide a header, click to clear the check box.  
The table updates to reflect the edit. 

Other Tables 
You can still open tables for items that have no representation graphically in the Project Explorer. These tables are 
still useful and can be accessed by clicking View Tables and then selecting either Camera, Layer, or View 
from the submenu.  
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See also: 
“Cameras”  
“Layers”  
“Views”  

Exporting Data 
Object tables provide an easy and convenient method for exporting data to another software application.  

To export data to another program, such as Microsoft Excel: 
1.  From the object table, select any row and column. 
2.  Press Ctrl+C to copy the selected data. 
3.  Open a document in the other program to which you want to export data. 
4.  Press Ctrl+V to paste the data into the document. 
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Chapter2  
Starting a Project 

ScanMaster organizes data into project archives. Each archive contains the main relational database and a 
collection of external resource files logically organized into folders. Data is stored in the main database when 
possible and in an external file when necessary due to performance constraints. 

This chapter includes the following: 
•  Creating a New Project 
•  Opening a Project 
•  Saving a Project 
•  Saving Screenshots  
•  Closing a Project 

Creating a New Project 
To create a new project: 
1.  Click File New or click the New Project  icon on the Standard toolbar. 

The New Project dialog box appears. 

 
Figure 3-1. New Project Dialog Box 

2.  Locate a folder in which to store the project, and then type a file name. 
3.  Click Save.  

ScanMaster creates a new project archive in the folder you located with the name you typed. 

Opening a Project 
To open an existing project: 

1.  Click File Open or click the Open Project  icon on the Standard toolbar. 
The Open Project dialog box appears. 

2.  Locate the folder in which the existing project is stored. When you roll over a file name, the file details appear 
for your convenience. 
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Figure 3-2. Open Project Dialog Box 

3.  Select a file, and the file name will appear in the File Name field. 
4.  Click Open.  

ScanMaster opens that project archive. 

Opening Recent Projects 
ScanMaster displays a list of the four most recently opened projects near the bottom of the File menu. If you 
select a file name from this list, ScanMaster opens that project file. 

Saving a Project 
It is recommended to save your project periodically and especially before you close it.  

To save a project, click File Save or click the Save Project  icon on the Standard toolbar. ScanMaster saves 
all changes to the project archive. 

Saving Screenshots  
When working in the 3D viewer window, you can capture screenshots and save them to a file, making it easy to 
use the screenshots in other applications, drawings, or reports.  
To capture screenshots:  
1.  Click on the window or table title bar that you want to capture. 
2.  Click File Save Screenshot.  

The Save As dialog box appears. 

 
Figure 3-3. Save Screenshot 

3.  Locate a folder in which to save the screenshot. 
4.  Enter a file name, and select an image format (.jpg, .bmp, .png).  
5.  Click Save.  

ScanMaster saves the screenshot of the current window or table. 
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Closing a Project 
To close a project, click File Close. If you have not already saved the project, a prompt appears asking if you 
want to save your changes. Click Yes or No. ScanMaster then closes the project. 
 

Importing a Project 
You can capture data with the data collector that is built into the GLS-1000 laser scanner without the need for 
ScanMaster. It is convenient, but you cannot verify what you have captured. All of the data is stored on the SD 
card, provided with the GLS-1000, that you insert into the laser scanner.  

1.  Once you have captured data using the GLS-1000, remove the SD card from the SD card slot. 
2.  Insert the SD card into your computer. 
3.  In ScanMaster, click File Import. 

The Import dialog box appears. 

 
Figure 3-4.  Import Dialog Box 

4.  Navigate to the SD card, select the GLS-1000 project file, as shown in  Import Dialog Box, and then click 
Open. 
The Import Project window appears, displaying the types of data on the card 

.  
Figure 3-5. Import Project 

The data files displaying a check mark will be imported. 
5.  Click to clear the check box of any item you do not want to import. 
6.  Click Import. 

ScanMaster imports all of the selected items. 
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Chapter3 
Printing 

You can print any of the tables and windows in ScanMaster. In the File menu there are three printing options: 

•  Page Setup  
•  Print Preview 
•  Printing  

Page Setup 
This opens the standard Page Setup dialog box, where you can select the following preferences: 

•  Paper size 
•  Paper source 
•  Orientation 
•  Margins 
•  Printer 
•  Printer Properties 

 
Figure 4-1. Page Setup Dialog Box 

Print Preview 
You can preview any window or table before printing it. To do this, click in the window or on the table title bar 
you want to preview, and then click File Print Preview or click the Print Preview  icon on the Standard 
toolbar. A preview window appears, displaying what the printout will look like. You can print directly from the 
preview window by clicking the print icon on the preview toolbar, or you can close the window by clicking Close. 
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Preview Toolbar

 
Figure 4-2. Print Preview 

Printing 
To print: 
1.  Click in the window or on the table title bar you want to print, and then click File Print or click the Print 

 icon on the Standard toolbar. The Print dialog box appears. 

 
Figure 4-3. Print Dialog Box 

2.  On the Print dialog box, select the necessary printing preferences, and then click OK. 
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Chapter4 
Viewer 

ScanMaster contains a Direct X viewer, capable of displaying all project contents in 3D. The viewer features a 
camera system that is capable of the following types of motion: 

•  Orbiting – The camera position rotates around the stationary target point. 
•  Swiveling – The camera target point rotates around the stationary position point. 
•  Panning – The camera position and target points translate in unison in regard to the view data. 
•  Zooming – The camera position and target points are stationary, while the view data is called up or down by a 

certain factor. 

This chapter includes the following: 
•  Navigation 
•  Views 

Navigation 
A navigation mode is a particular mapping of mouse buttons to camera motions. These modes are listed in the 
View menu (seeNavigation Submenu) and on the Display toolbar under the Navigation  drop-down menu. 

 
Figure 5-1. Navigation Submenu 

The viewer supports three navigation modes: 

•  Cube : The cube navigation mode is helpful for processing the data in the office. You can view the data 
from any direction:  

•  If you press and hold the left mouse button and move the pointer around, the camera orbits around the 
target point that is placed somewhere in the view.  

•  If you press and hold the right mouse button and drag the pointer around, the camera pans around the 
view. 

•  If you press and hold both buttons or hold down the scroll wheel, the camera zooms in and out.  

•  Sphere : The camera is fixed in place and shows the inside of the bounding sphere of the view. The sphere 
mode is useful in the field while you are capturing the data because it allows you to place the virtual camera 
inside ScanMaster at the same position as the real camera inside the laser scanning instrument in the field. 
This provides an exact view of what the instrument is looking at when you are capturing the data. It also 
makes it easier to define the area you want to photograph or scan.  
Some information can only be displayed in the sphere view. For example, it is not possible to display digital 
pictures captured with the internal GLS-1000 camera in the cube view because they cannot be properly 
overlaid on top of the data. In the sphere view, however, because the position can be set exactly where the 
instrument was located, the view becomes panoramic. 
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You can view the data from several direction: 
•  If you press and hold the left mouse button and move the pointer around, then the camera swivels up, 

down, left, or right.  
•  If you roll the mouse scroll wheel or press and hold the right mouse button and move the pointer around, 

then the camera zooms in and out.  
•  If you press and hold the scroll wheel or both buttons, then the camera pans around the view.  

•  Target Scans : This mode only displays target scans in order to properly align the scans and the pictures. 
Target scan navigation is just like Sphere navigation. In other modes, target scans do not show up at all.  
You can view the data from several direction: 

•  If you press and hold the left mouse button and move the pointer around, then the camera swivels up, 
down, left, or right.  

•  If you roll the mouse scroll wheel or press and hold the right mouse button and move the pointer around, 
then the camera zooms in and out.  

Views 
ScanMaster provides quick access to several standard camera orientations and visual aids. 

Projection 
The viewer supports multiple camera projects. You can set a different projection for each open view; however, 
ScanMaster must be in the Cube navigation mode. SeeNavigation. The projections are listed in the View menu: 

•  Parallel : Objects are drawn at a constant scale regardless of their distance from the camera position. This 
projection is not available during spherical navigation. The viewer switches from spherical to cubic navigation 
if this projection is selected. 

•  Perspective (default) : Objects are drawn at a variable scale in proportion to their distance from the camera 
position. For example, objects get smaller the further away they are from the camera. This projection produces 
photo-realistic results. Newly opened views default to this projection.  

To see the current camera parameters, you can open the View Properties window by clicking 
View Windows View Properties or by clicking the View Properties  icon on the Standard toolbar. This 
window provides information on the position and orientation of the camera, zoom level, field of view, projection 
type, and extents of the current dataset. You can manually enter a position for the camera or a target point to look 
at. For example, you can look at a known control point and see where if falls on the dataset. 

 
Figure 5-2. View Properties Window 

Set Target 
The camera always orbits or zooms in on a target point on the screen. When working with an area of the laser scan, 
always set the target in that area, especially if you want to zoom in on a distant area. This moves the camera and 
focuses it on that location.  
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To do this:  
1.  Click View Set Target or click the Set Target  icon on the View toolbar. 
2.  Ctrl+click on the target you want to set. These instructions also appear in the prompt line at the bottom of the 

screen. 
The camera adjusts to the new target point. 

3.  Ctrl+(right-click) to end the Set Target routine. 
If you swivel the view, then it orbits around the target you set.  

Zooming Options 
During a zoom motion, the camera position and target points are stationary while the view contents are scaled up 
or down by a certain factor. You can access zoom options by clicking View Zoom. The zoom options are listed 
in the Zoom submenu. Or, you can click on a zoom icon in the Display toolbar. Use the pointer to rollover an icon 
to display its name. 

View Menu Zoom Options

Display Toolbar Zoom Options

 
Figure 5-3. Zoom Options 

The different zoom levels include the following: 

•  Zoom Extents adjusts the zoom level, so you can see the entire dataset. This is useful as a starting point for 
working with 3D data or for resetting the camera.  

•  Zoom Selection adjusts the zoom level, so the entire contents of the current selection is visible on the screen. 
•  Zoom Top moves the camera position to the top of the view and the camera target point to the center of the 

view. 

•  Zoom Bottom moves the camera position to the bottom of the view and the camera target point to the center 
of the view. 

•  Zoom Left moves the camera position to the left of the view and the camera target point to the center of the 
view. 

•  Zoom Right moves the camera position to the right of the view and the camera target point to the center of 
the view. 

•  Zoom Front moves the camera position to the front of the view and the camera target point to the center of 
the view. 

•  Zoom Back moves the camera position to the back of the view and the camera target point to the center of the 
view. 

Viewer Aids 
ScanMaster provides several visual tools to apply to the view data. You can access these visual aids by clicking 
View Aids and then selecting an option to turn it on or off. A check mark indicates it is turned on. 
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Figure 5-4. Visual Aids Options 

ScanMaster associates a specific color with each positive coordinate axis. The default association is X=red, 
Y=green, and Z=blue. You can customize all of the visual aid tools using the program options by clicking 
Tools Option. For more information about the program options, see “Program Options Window”. 

The visual aid tools include: 
•  Axes: The coordinate axes tool appears by default in the lower left corner of the Viewer Window. The 

orientation of this tool always reflects the orientation of the axes of the active camera. The colors associated 
with the axes also appear on the bounds. 

 
Figure 5-5. Visual Aid - Coordinate Axes and Colored Cubic Bounds 

•  Bounds: During cubic navigation, the viewer displays a bounding box tool. SeeVisual Aid - Coordinate Axes 
and Colored Cubic Bounds. During spherical navigation, the viewer displays a bounding spherical tool. 
SeeVisual Aid - Spherical Bounds. 

 
Figure 5-6. Visual Aid - Spherical Bounds 

For screen shots, it may be helpful to turn off the bounds tool from view. 

•  Grid: During cubic navigation, the viewer displays a rectilinear grid tool. 
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Figure 5-7. Visual Aid - Grid (Cube) 

During spherical navigation, the viewer displays a polar grid tool. In the spherical navigation, the grid is 
especially important because it helps define areas of the scanned image with the GLS-1000 laser scanner. 

 
Figure 5-8. Visual Aid - Grid (Sphere) 

 If high-end display card is used in your PC, it is smoothly displayed by set to "TRUE" mode of the "Hardware 
Acceleration" in "Program Option Window". 

 
•  Legend: This tool is usually hidden from view until you select the Data Color Elevation command, 

which colors the view data by elevation. When you select this command, the view data becomes colored and 
the legend (long, thin bar) docks on the side of the screen, showing the relationship between the different 
colors in the view and the associated numerical values. See You can turn the legend off or realign it using the 
Program Options window. See “Program Options Window”.  

 
Figure 5-9. Visual Aid - Legend 

 

 
 
 
 



Chapter6  Cameras 

32 

Chapter5 
Views 

When you create a new project, ScanMaster automatically displays a 3D graphical Viewer Window called Default. 
You can change the Viewer Window or create additional views. 

 
Figure 6-1. Default Viewer Window 

A view contains a collection of display settings and references to other objects in the project. With each view, you 
can choose which parts of the project you are looking at and how you look at them. 

This chapter includes the following: 
•  Using the Project Explorer to Ch 
•  Creating Multiple Views 

 

Using the Project Explorer to Change a View 
Use the Project Explorer window (View Windows Project Explorer) to change the display of any object in 
the project. In the Project Explorer, each object in the project contains a check box next to its name. Select the 
check box to show the object in the active Viewer Window or clear the check box to hide it. Select the check box 
next to a folder to display all of the objects within it, or clear the folder check box to hide them. The fastest way to 
display all of the objects is to select the check box next to the project name listed at the top.  

 
Figure 6-2. Project Explorer 
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To view objects in a Viewer Window that was previously empty, you may need to zoom in on the object(s) you 
selected by clicking View Zoom Extents or by clicking the Zoom Extents  icon on the Display toolbar. 
The objects in the Viewer Window become more visible, as shown inZoom Command.  

 
Figure 6-3. Zoom Command 

Creating Multiple Views 
You can create more than one view to display data from different scan positions. All project views can be 
managed in the Views table, which is docked at the bottom of the window inViews Table. 

To open the Views table, click View Tables View.  

 
Figure 6-4. Views Table 

Each tab in the Viewer Window is represented in the Views table. When you first open the Views table, the 
Default tab may be the only position displayed in the table, as shown inViews Table.  

To create a view for each scan position, click Create View or right-click in the Views table and select Create 
View. A new row appears in the table, and a new tab appears in the Viewer Window. In the Views table, the 
Active Arrow  icon indicates the most recently selected row. 

Naming Views 
Each new view is assigned a default name of View 01, 02, and so on. 

To rename a view: 
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1.  In the Views table, select the view you want to rename in the Name column. The entire field becomes 
highlighted. 

2.  Click it again to highlight just the name and not the entire field. 
3.  Type a new name, and then press Enter. As you type a new name, a pencil appears in the far left column, as 

shown inAdditional Views. 

 
Figure 6-5. Additional Views 

To show data on a tab:  

1.  Select the tab in the Viewer Window. 
2.  In the Project Explorer, select the Scan Position check boxes of the data you want to view.  
3.  To zoom in on the data, click the Zoom Extents  icon on the Display toolbar or click 

View Zoom Extents. 

Showing or Hiding Objects 
There are several ways to show or hide objects in the Viewer Window: 

•  Project Explorer – Selecting the check box next to an object shows that object in the Viewer Window. To hide 
an object, click to clear the check box next to it. 

•  Edit Menu – Select the object, and then click Edit Hide or File Show. 
To close a tab, select it and do one of the following:  

•  In the Views table, click to clear the Show check box next to the view name.  
•  Click the Close  icon on the upper right side of the Viewer Window.  
•  Right-click on the tab name, and select Close. 

To open a tab, select the Show check box in the Views table next to the tab name in which you want to open. 

Deleting Views 
To delete a view: 
1.  Select the row you want to delete in the Views table.  
2.  Make sure you select the entire row by clicking the row in the furthest left-hand column.  

The row turns blue. 

 
Figure 6-6. Selected Row 

3.  Click Edit Delete.  
A confirmation window appears. 

4.  Click Yes.  
The row disappears from the Views table, and the corresponding tab disappears from the Viewer Window. 

Views Table Properties 
The Views table enables you to quickly customize data and objects on the view tab. To learn more about how to 
use the table properties for customization, seeViews Table Definitions. 
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Table 6-1. Views Table Definitions 

Field Definition 

Image This icon represents a type of object in ScanMaster. Because a table shows objects of the same 
type, every image in this column is the same. 

Name The name of the view and the corresponding view tab in the Viewer Window. 

Show Select this check box to show the view tab in the Viewer Window or clear it to close the view tab.

Camera This column lists all of the cameras (position, orientation, zoom level, etc.) for the table, 
beginning with the default camera for a view. When this view is opened, ScanMaster 
automatically loads the camera settings. To save the current camera settings, click 
Create Camera.  

Data Color These options color the data. See also “Color Modes”. 
Elevation: Colors data points according to elevation. 
Intensity: The return intensity of the laser beam. 
Image: After a scan is colored from images (digital photographs), this option applies real-world, 
photo-realistic colors to all of the points. 
Layer: The color assigned to the layer. 

Display Normal Data When this check box is selected, all data points that were not marked as “hidden” or “deleted” are 
displayed. 

Display Hidden Data Select this check box to display data that was hidden from view in order to focus on a data 
selection. See also “Showing Cloud and Scan Points” . 

Display Deleted Data Select this check box to display data that was deleted in order to “clean up” the dataset. See 
also“Restoring Deleted Points”. 

Point Size This controls the size of individual points in the view. The large size may be easier to see. This 
setting only applies if the “Automatic Point Size” is not selected. 

Automatic Point Size ScanMaster automatically applies a point size based on camera position, orientation, zoom level, 
etc. 
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Chapter6 
Cameras 

A camera is a way to store the current settings of a view for future reference.  

This chapter includes the following: 
•  Saving the Current Camera 
•  Recalling a Saved Camera 
•  Setting the Default Camera 
•  Deleting a Saved Camera 

Saving the Current Camera 
Saving the current camera enables you to save a view of a particular area of data, so you can switch cameras or 
close the program and easily return to the camera view you saved.  

To save the current camera, click Create Camera.  
To see a table of all of the camera views available in a project, click View Tables Camera. This table lists 
attributes for all of the cameras you previously saved. 

 
Figure 7-1. Cameras Table 

From the Cameras table, you can edit any of the camera attributes. 

 

Recalling a Saved Camera 
To recall a previously saved camera, you can: 

•  Select the entire row of the camera you want to recall by clicking in the far left field, and then clicking 
Edit Activate.  

•  Right-click on the camera name in the table, and select Activate from the shortcut menu. 

Setting the Default Camera 
When you open a new view, by default, it is always shown from the top perspective; however, this may not be the 
best way to view the data. You can customize the view so it uses a certain camera by default whenever you open 
it.  
To set the default camera: 
1.  Click View Tables View.   

The Views table appears, displaying a default camera option you can customize.  
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Figure 7-2. Views Table 

2.  In the Camera drop-down menu, select the camera view you want to set as the default. 
3.  Make sure the Show check box is selected. 

The default camera automatically resets to the camera you selected. 

Deleting a Saved Camera 
To delete a saved camera: 

1.  From the Cameras table (View Tables Camera) select the entire row of the camera you want to delete by 
clicking in the far left field.  
The entire row turns blue. 

2.  Select Edit Delete or right-click and choose Delete from the drop-down menu. 
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Chapter7 
Selecting Objects 

ScanMaster provides two methods for selecting objects: 

•  Graphical Selection  – Select objects by choosing their graphical representation in the Viewer Window. 
•  List Selection – Select an object by clicking its name in the Project Explorer or in one of the object tables 

Graphical Selection  
Before you select an object in the Viewer Window, choose one of two selection modes from the Select Mode 
menu: 

•  Objects: This lets you select everything except laser scanner measurements. If the object you are trying to 
select is listed in the Project Explorer with an individual entry, such as Point 004 or Polyline 001, then use the 
Object mode. 

•  Data: This lets you select individual laser scanner measurements. If the object you are trying to select is listed 
along with other items bundled inside an entry, such as Scan 001 or Cloud 001, then use the Data mode. 

 

You can also choose one of these modes from the 
Selection Mode  icon on the Select toolbar. 

Object Mode 
In the Object mode, choose from three commands to select the objects graphically. You can access these 
commands from the Select menu or by clicking the appropriate icon on the Select toolbar. When you click on 
these commands, instructions appear in the prompt line in the lower left corner of the window. 

These selection commands are:  
•  Point : Selects an object using the pointer. Click on an object to select it, and right-click to stop the point 

selection. 
•  Rectangle : Selects all objects inside a rectangular window. Click on a point to begin drawing the rectangle 

selection window and click again to stop the selection. All objects inside or intersecting the rectangular 
boundary are selected. 

•  Polygon : Selects all of the objects inside an irregular polygonal boundary. Click on different locations 
within the Viewer Window to define the boundary. Right-click to complete the selection, and right-click again 
to stop using the selection method entirely. This is a useful tool when you need to select objects that are inside 
cluttered areas on the screen. 

Object selection applies to every open view in ScanMaster. This means that objects selected in one view will also 
be selected in other open views.  
For more information about selecting objects graphically, see also Selection Keysand Selection Options. 

Data Mode 
In the Data mode, choose from three commands to select laser scan points (not objects). You can access these 
commands from the Select menu or by clicking the appropriate icon on the Select toolbar. When you click on 
these commands, instructions appear in the prompt line in the lower left corner of the window. 
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These selection commands are:  
•  Point : Selects data using the pointer. Click on data to select it, and right-click to stop the point selection. 
•  Rectangle : Selects all data inside a rectangular window. Click on a point to begin drawing the rectangle 

selection window and click again to stop the selection. All data inside or intersecting the rectangular boundary 
are selected. 

•  Polygon : Selects all of the data inside an irregular polygonal boundary. Click on different locations within 
the Viewer Window to define the boundary. Right-click to complete the selection, and right-click again to 
stop using the selection method entirely.  

In Data mode, selection applies only to the current view and not to other open views in ScanMaster. This is useful 
for view editing and data cleanup. 

For more information about selecting points, see also Selection Keysand Selection Options. 

Selection Keys 
There are three keys you can use to assist with graphical selection: 

•  Shift - Lets you add new objects to the current selection set by holding down the Shift key while selecting 
objects. 

•  Alt - Lets you remove objects from the selection set by holding down the Alt key while selecting objects. 
•  Ctrl - Lets you switch the selection set. Any objects that were previously selected become unselected and vise 

versa. 

Selection Options 
In the Select menu and on the Select toolbar there are additional commands to help you with graphical selection: 

•  (Select) All : Selects all points or objects in the view. 

•  (Select) None : Clears all selected objects. 
•  Invert (Selection) : Switches the selection of the current Viewer Window, either object or data, to the 

reverse mode. 

 
Figure 8-1. Invert Selection 

List Selection 
List Selection is the method of selecting objects that is distinct from selecting the graphical representation in the 
3D Viewer Window. If you know the name of an individual object, then using this method is a quick way to select 
an object. If you don’t know the name of the object, then you might have to select several objects in a list before 
you get to the right one.  

There are two primary list selection methods: 
•  Project Explorer: In the Project Explorer, click the name (not the check box) of the object you want to select, 

and it becomes highlighted in the Viewer Window. Only one object can be selected at a time.  
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Figure 8-2. Project Explorer Selection 

•  Object Table: Click the row of an object in one of the object tables, and it becomes highlighted in the Viewer 
Window. 

 
Figure 8-3. Object Table Selection 

In an object table, you can select multiple objects by holding down the Shift key to choose consecutive rows 
or the Ctrl key to choose various rows. You can also use the Select menu commands: All, None, and Invert. 
For more information on Select menu commands, see Selection Options.  

 

When using an object table, you can only select 
objects of that type. For example, if you are using 
the Point Object Table, you can only select points 
and no other type of object. 
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Chapter8 
Layers 

A layer is a tag that you can assign to any object. That tag is associated with a set of display settings, such as 
visibility, color, line type, line width, and point size. The Layer Table contains all of the project layers and helps 
you manage all of the object display properties. 

This chapter includes the following: 
•  Using the Layer Table 
•  Creating Layers 

Using the Layer Table 
To open the Layer Table, click View Tables Layer or click the Layer Table  icon on the Layer toolbar. 
The Layer Table appears docked at the bottom of the window. 

 
Figure 9-1. Layer Table 

The Layer Table contains a default layer called 0. You can neither delete nor rename the default layer, but you 
can edit its other attributes. The layer table applies to all views. To learn more about using the Layer Table to edit 
attributes, seeLayer Table Definitions.  

Table 9-1. Layer Table Definitions 

Attribute Definition 

Image Displays a thumbnail of the image assigned to the ayer.  

Name Displays the layer name. 

Show Displays the layer in the Viewer Window when the check box is selected. 
To hide the layer, click to clear the check box. 

Color Assigns a color to the layer. Click the drop-down menu and select a color. 

Point Size Assigns a point size to the layer.  

Line Type Assigns a line style to the layer. Click the drop-down menu and select a 
style. 

Line Width Assigns a line thickness to the layer.  
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Creating Layers 
To create a new layer, click Create Layer or click the Create Layer  icon on the Layer toolbar. A new 
layer appears at the bottom of the Layer Table. To rename this layer, click on its name, type a new one, and then 
press Enter. 

Once you create a new layer, you need to assign it to an object. To do this, select the object and select the name of 
the layer you want to assign it to using the Layer toolbar.  

 
Figure 9-2. Layer Toolbar 

This toolbar displays the layer of the currently selected object and lets you change the layer to another one in the 
project. ScanMaster updates the project to reflect the layer change.  
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Chapter9 
Color Modes 

Color modes are a technique for coloring the data to get a better sense of what was captured with the laser scanner. 
You can see a list of all available color modes in the Data Color menu. Currently, there are four modes 
available: 

•  Elevation  
•  Image  
•  Intensity (BW) 
•  Intensity (RGB) 
•  Layer  

Elevation  
ScanMaster recolors all data points in the current view according to elevation. Points close to the ground plate are 
colored in blue; points in the middle are colored in green; and points higher up are colored in red. If the Legend 
option is enabled (View Aids Legend), then a legend appears docked on the screen. It shows exactly which 
color represents which elevation. You can show or hide the legend or realign it using the “Program Options 
Window”. 

 
Figure 10-1. Color Mode - Elevation 

Image  
The data has been colored from images (digital photographs). Before this option is available, you have to texture 
map images onto the laser scan data. See also “Texture Mapping Images onto Scan Data” . If you haven’t mapped 
images onto the laser scan data, then all the points will be colored in black. 
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Figure 10-2. Color Mode - Image 

Intensity (BW) 
This refers to the return intensity of the laser beam, as shown by the colors black and white. Surfaces that are 
darker and have lower return intensity are colored in black; surfaces with medium return intensity are colored in 
gray; and surfaces with high return intensity are colored in white.  

 
Figure 10-3. Color Mode - Intensity (BW) 

Intensity (RGB) 
This refers to the return intensity of the laser beam, as shown by the colors red, green, and blue. Surfaces that are 
darker and have lower return intensity are colored in blue; surfaces with medium return intensity are colored in 
green; and surfaces with high return intensity are colored in red. 

 
Figure 10-4. Color Mode - Intensity (RGB) 
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Image  
The data has been colored from images (digital photographs). Before this option is available, you have to texture 
map images onto the laser scan data. See also “Texture Mapping Images onto Scan Data”. If you haven’t mapped 
images onto the laser scan data, then all the points will be colored in black.  

 
Figure 10-5. Color Mode - Image 

Layer  
The data is colored according to the color assigned to the layer. Coloring by layer is useful when you have data 
from more than one scan or point cloud in the same view. If you assign the scans or clouds to individual layers, 
then you can see which points came from which scan. See Color Mode - Layer. If you have a dataset loaded into 
more than one view, you can color it according to a different color mode in each view. For information about 
assigning a color to a layer, see “Using the Layer Table”.  

 
Figure 10-6. Color Mode - Layer 

To switch color modes, click Data Color, and choose another color option. 
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Chapter10 
Scans and Images 

A 3D laser scan produces a highly detailed, “field condition” snapshot of the physical space that you can refer to 
and analyze at any time on your office computer. This chapter shows you how to capture that “snapshot” using 
images and scans taken directly from the GLS-1000. 

This chapter includes the following: 
•  Scan Positions 
•  Images 
•  Scans 
•  Target Scans 

Scan Positions 
Data is acquired from different scan locations for a more accurate dataset of the object’s surface. These locations 
are called scan positions, and each one has its own local coordinate system. Later, you can merge or register 
multiple scan positions into the project coordinate system. See “Registration”. 

Creating Scan Positions 
Before you can create a scan or image, you must have at least one scan position in the project. 

To create a scan position: 
1.  ScanMaster must be connected to the instrument. For connection information, see Connecting to the Laser 

Scanner.  
2.  Click Create Scan Position or click the Create Scan  

Position  icon on the Create toolbar.  
Scan Position 01 appears in the Project Explorer. 

 
Figure 11-1. Project Explorer - Scan Positions 

The scan position has folders to keep images, scans, target scans, and tie points organized. The scan position 
appears in bold typeface to indicate it is the currently active scan position in which all captured data appears. 
A newly created scan position automatically becomes the active scan position.  
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Setting the Active Scan Position 
To set the active scan position, select the scan position you want to activate and then click Edit Activate. Or, 
right-click on the scan position and select Activate from the shortcut menu. 

 

If you move the instrument, you have to create a 
new scan position. 

Images 
An image is a digital photograph. With images, you can: 

•  Streamline the data acquisition process of scanned data because you can figure out exactly which areas you 
want to scan. 

•  Apply actual RGB (Red, Green, and Blue color model) data to scanned measurements.  

Creating Images 
To create images: 

1.  Make sure ScanMaster is connected to the instrument. For connection information, seeConnecting to the Laser 
Scanner.  

2.  Make sure you have at least one scan position in the project. See alsoCreating Scan Positions. 
3.  Click Create Scans and Images.  

This option will not be available if steps one and two have not been completed. 
The Capture Scans and Images dialog box appears. 

 
Figure 11-2. Capture Scans and Images Dialog Box 

This dialog box helps you specify which area you want to image and at which resolution. The viewer window 
automatically switches to spherical navigation. 

4.  In the Create panel, select Images Only.  
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5.  In the Angles panel, specify the area you want the instrument to cover, using the Start and Stop/Azimuth and 
Zenith angles.  
The angles on the grid correspond to the angles specified in the dialog box. Azimuth angles are horizontal 
angles that run from side-to-side through the center of the screen. Azimuth angles decrease from the left of 0 
and increase to the right. The GLS-1000 starts scanning on the left side of the screen and proceeds to the right.  
Zenith angles are vertical angles that run from the top to the bottom of the screen. The values increase in the 
upwards direction and decrease in the downward direction. Because the GLS-1000 processes data from top to 
bottom, the Zenith start angle is at the top and the stop angle is at the bottom. 
To specify the coverage area: 

•  Using the Angles Fields – Enter a value or use the up and down arrows to select a value in degrees in the 
Start/Azimuth and Stop/Azimuth fields. Repeat this process in the Start/Zenith and Stop/Zenith fields. 
ScanMaster automatically restricts you to the field of view of the instrument. 

•  Using Video Streaming – Make sure the On option is selected in the Device Properties window 
(View Windows Device Properties). In the Capture Scans and Images dialog box, click the Set  
button at the end of the start row, and then Ctrl+click in the 3D viewer where you want to set the Start angle. 
The scanner automatically rotates to the point you specified and because the live video stream was turned on, 
you can visually verify if that is the area you want to process.  
To change the start angle, click on another position and compare it on the video screen. The Start/Azimuth 
and Start/Zenith angles are automatically updated to correspond to the point you clicked.  
Once the Start angle is set, then Ctrl+(right-click) in the viewer window to stop the process. Repeat this 
process for the Stop/Azimuth and Stop/Zenith angle. These instructions also appear on the status bar on the 
lower left side of the screen.  

 

If you turn off the live video streaming, and click a 
Set button for an angle, the directions on the status 
bar are different. You can still press Ctrl+click to 
set the angle, but the live video stream no longer 
updates.  

 
•  Using Key-Board 

Left click on the live video, then turn clicked point and it can turn using key-board. 
Shift + left, right, up, down key : Faster speed turn 
left, right, up, down key : Normal speed turn 
Ctrl + left, right, up, down key : Slower speed turn 

•  Using Jog Dials – You can use the jog dials on the side of the GLS-1000 and a special view finder in the 
instrument mirror to aim at the point you want to use as angles. Press the Enter button on the instrument, then 
the angles you aimed at automatically appear in the angle fields in the Capture Scans and Images dialog 
box.  

6.  Specify the image resolution by clicking on the Resolution drop-down menu in the Images panel and 
selecting an option.  
The GLS-1000 supports three different resolutions: 300x400 pixels, 600x800 pixels, and 1200x1600 pixels. 
The medium setting of 600x800 is a balance between smaller memory size (300x400) and quality 
(1200x1600). You can also specify overlap angles that determine how much the pictures overlap. 
Furthermore it can select way of adjust WB to center of shooting area(global) or each image(local).  

7.  Be sure to review the information in the Summary panel. This shows ScanMaster’s estimation of how many 
pictures are required to cover the area specified and how long the process will take.  

8.  Click Device Tasks to start the imaging process. The Device Tasks manager appears with a task listed in the 
table.  

9.  Click Start.  
The scanner reorients itself to look at the start point you specified and then continues taking pictures to cover 
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the entire area you requested. The images automatically align with each other using the calibration settings 
from the scan. The images appear in the Project Explorer (active) Scan Position Images folder.  
You can use the images and apply the true RGB (Red, Green, Blue) color model to the scan data in your 
project. See Texture Mapping Images onto Scan Da. 



Chapter10  Scans and Images 

50 

Images of Poor Quality 
To hide or delete images of poor quality: 
1.  Click Select Objects and then choose the point, rectangle, or polygon selection tool to select the image. 
2.  Click Edit Hide or Edit Delete.  
3.  Define a new image task to cover the area you hid or deleted. 
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Connecting to the Laser Scanner 
There are two methods for connecting your computer to the GLS-1000 laser scanner. You can connect via USB 
cable or by Wireless LAN. 

To connect your computer to the GLS-1000: 
1.  Follow the connection instructions in the GLS-1000 hardware manual in the Network Settings section. These 

instructions guide you through both Wireless LAN and USB connection.  
 

If you are using a Wireless connection, be sure to 
note the IP address of the GLS-1000. You will 
need to enter it later. 

 
2.  Once your computer is connected to the laser scanner, click on the connection status button in the left corner 

of the screen. 

 
Figure 11-3. Connection Status Button 

3.  In the Device Connection window (seeDevice Connection Window), do one of the following: 
•  If you are using a USB cable for connection, then select the USB option and click OK. 
•  If you are using a wireless LAN connection, then select Wi-Fi and enter the GLS-1000 IP address you noted 

earlier. Click OK. 

 
Figure 11-4. Device Connection Window 

The Connection Status button in the lower left corner turns green and states “Connected” when the 
connection is established. 
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Scans 
With scans, you take the pictures first and then specify the area to scan on the pictures. 

Capturing Scans 
To capture a scan: 

1.  Make sure ScanMaster is connected to the instrument. For connection information, see Connecting to the 
Laser Scanner.  
When the status bar in the lower left corner states “Connected,” highlighted in green, then the instrument is 
connected. 

2.  Make sure you have at least one scan position in the project. See alsoCreating Scan Positions. 
3.  Click Create Scans and Images.  

This option will not be available if steps one and two have not been completed. 
The Capture Scans and Images dialog box appears. 

 
Figure 11-5. Capture Scans and Images Dialog Box 

This dialog box helps you specify which area you want to scan and at which resolution. The viewer window 
automatically switches to spherical navigation. 

4.  In the Create panel, select Scan Only.  
5.  In the Angles panel, specify the area you want to scan, using the Start and Stop/Azimuth and Zenith angles.  

The angles on the grid correspond to the angles specified on the dialog box. Azimuth angles are horizontal 
angles that run from side-to-side through the center of the screen. Azimuth angles decrease from the left of 0 
and increase to the right. The GLS-1000 starts imaging from the left to the right side of the screen.   
Zenith angles are vertical angles that run from the top to the bottom of the screen. The values increase in the 
upward direction and decrease in the downward direction. Because the GLS-1000 processes data from top to 
bottom, the Zenith start angle is at the top and the stop angle is at the bottom. 

1.  Click the Set  button at the end of the Start row. Instructions appear in the lower left corner of the 
screen. 

2.  Ctrl+click on the upper left corner of the picture to specify the Start angle, and then Ctrl+(right-click) 
to end the process. 

3.  Click the Set button at the end of the Stop row. 
4.  Ctrl+click on the far right corner of the picture you want to scan, and then Ctrl+(right-click) to end the 

process. 
6.  Specify the resolution for the scan by doing one of the following: 
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1.  Enter or select the angle, which is how much the turret and mirror of the instrument turned while it 
was capturing data. For example, you can enter 12 percent of a degree, which means that the 
instrument rotated by 12 percent of a degree while capturing information.  

2.  Enter or select the spacing on a surface that is some distance away from the instrument. Because you 
cannot obtain even spacing on objects that are different distances away from the instrument without 
making two separate scans, estimate the range to the surface you are scanning by clicking the Range 
to Surface  icon. The directions for estimating the range to surface appear in the status bar. 
Ctrl+click anywhere on the image or scan to measure the distance to that point. Once the distance is 
measured, the value appears in the Range to Surface field. Ctrl+(right-click) to end the process. With 
the distance displayed, you can enter the value in the Range to Surface field into the Distance field.  

3.  Enter or select a number of points. For example, you can enter 250 points in the horizontal direction 
(Azimuth).  

4.  To keep the Azimuth and Zenith spacing between the points equivalent to each other, click the Equal 
 button as soon as you edit a resolution field. The value in the corresponding field adjusts to get as 

close to equivalent as possible. For example, if you edit the Zenith field and then click the Equal 
button, the Azimuth field updates. Also, if you change a resolution value, such as the Angle, the other 
fields, Distance and Point, automatically update to reflect the setting, so you always know what type 
of spacing you have between the points. 

7.  Be sure to review the information in the Summary panel. This shows ScanMaster’s estimation of how many 
pictures are required to cover the area specified and how long the process will take.  

8.  Click Start to begin the scanning process.  
The scan appears in the Project Explorer (active) Scan Position Scans folder. You can see the scan 
points appear in real-time, and you can switch to cube navigation mode to see the full 3D picture of your data. 
The images are only visible in the sphere navigation mode.  

See also, Texture Mapping Images onto Scan Da. 

Texture Mapping Images onto Scan Data 
Texture mapping enables you to apply the correct Red, Green, and Blue color model from the pictures you 
captured to the scan data. 

To do this:  
1.  Load all of the images you want to apply to the scanned data into the viewer window by selecting the check 

boxes next to their names in the Project Explorer.  
2.  In the Project Explorer, click to highlight the scan you want to color from the images.  
3.  Click Edit Color from Images.  

This process can take a little while with larger scans.   
4.  Click Data Color Image to get the correct color for the data you captured. 
 

Exporting Scans and Images 
You can export data, including scans, images, and target scans, with common file formats from a ScanMaster 
project to another project in ScanMaster or a different program. 

To export data: 
1.  Set up a folder structure in which to place the data you want to export. For example, create the folders 

Export Scan Position O1 Images.     
2.  In the Project Explorer, right-click on the folder of the data you want to export and select Table from the 

shortcut menu. See Images Table (Right). 
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Figure 11-6. Images Table (Right) 

3.  In the table, select the data you want to export. To select all of the data, click the Select All  icon on the 
Select toolbar. To select multiple items, press the Ctrl key while making your selection. 

4.  Right-click on a selected item and select Export from the shortcut menu. 
The Export dialog box appears. 

 
Figure 11-7. Export Dialog Box 

5.  Locate the folder you created in Step 1 and then from the Save as type drop-down menu, select a format in 
which to export the data. 

6.  If you want ScanMaster or another program to properly orient the data you exported, then repeat Step 5 and 
select the following format types from the Save as type drop-down menu: Angle, Calibration, and 
Orientation. 

 
Figure 11-8. Images Folder has Four Formats per Data File: JPEG, Angle, Calibration, and Orientation 

All of the exported data is categorized by type and is ready for importing into another project or program.  
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Importing Scans and Images 
To import data into a ScanMaster project: 

1.  In the Project Explorer, create folders for the type of data you want to import if they do not already exist. For 
example, if you are importing a scan position (images, scans, and target scans), then create a new scan 
position (Create Scan Position). 

2.  Right-click on the folder in which you want to import the data and select Import from the drop-down menu. 
The Import dialog box appears. 

 
Figure 11-9. Import Dialog Box 

3.  Select all of the items you want to import, and then click Open. ScanMaster imports all of the formats with 
the same file name into the folder you selected. 

Target Scans 
A target scan is a very accurate, high-detail scan of a retro-reflective target. A retro reflective target is a shape 
made of special material that has specific reflective properties that make these targets standout from other types of 
objects inside of a laser scan. During laser scanning, targets are used primarily to link data from the individual 
coordinate systems of the scan positions into the global project coordinate system. Targets can be used for 
occupation and backsight registration or during tie point-based registration. 

Capturing Target Scans and Creating Tie Points 
To capture a target scan and create a tie point: 

1.  Make sure ScanMaster is connected to the instrument. For connection information, see Connecting to the 
Laser Scanner.  

2.  Make sure you have at least one scan position in the project. See also Creating Scan Positions. 
3.  Click Create Target Scans.  

This option will not be available if steps one and two have not been completed. 
The Capture Target Scan window appears. 

 
Figure 11-10. Capture Target Scan 

The Search Area field shows the parameters of the scanner’s search. For example, if the Search Area field 
shows two degrees, then the scanner will search one degree to the left and one degree to the right of the 
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location you click on and one degree above and one degree below it. And, enter target height to Target Height 
field and set. 
It is always best to use a search area that is wider than the target, so the entire target fits into the search area. 
Also, it is okay to have several targets close to each other and even in the same search area. The scanner 
focuses on the target that is closest to the specified location. 

4.  To see the progress of the capture and any queued target scanning tasks, click View Windows Device 
Tasks. This window appears empty until a target scan task is initiated. 

5.  To initiate a target scan, Ctrl+click on the image or scan near the center of the retro reflective target you want 
to scan. 
The target scanning task appears in the Device Tasks window.   

6.  Ctrl+(right-click) on the location where you want to end the scan. This begins the target scanning process.  
The Device Tasks window shows the progress of the scan. The scan points appear on the screen in real-time 
as the scanning process progresses. The scanner might rescan the same target several times or readjust the 
scan area, resolution, and zoom level to get the best possible measurement to the exact center of the reflector. 
The target scan has a slight offset from the image and the other scan data; however, the actual measurement is 
precise and will fit with the data. If you select the target scan from the Project Explorer, you will notice a faint 
boundary that corresponds to the least square ellipse that was fitted to the points. Basically the boundary 
should fit exactly to the scan outline.  

7.  Once the target scan is completed, click Edit Create Tie Point or click the Create Tie Point  icon to 
create the tie point that was measured for the exact center of the scan. 

8.  To view the target scans, switch the navigation mode to Cube by clicking View Navigation Cube.  
 

You cannot view target scans in 3D. You can only 
view them in the flat spherical mode. 
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Chapter11 
Registration 

Registration is the process of aligning data taken from different scan positions into the same global coordinate 
system.  
This chapter includes the following: 

•  Registering Tie Points 
•  Georeferencing 
•  Occupation and Backsight Re 

Registering Tie Points 
When you capture data from two different scan positions, the data is not aligned. This is because the 
measurements the scanner takes are always recorded in the local coordinate system of the scanner. The scanner 
cannot determine that it was moved to a new position, so it does not align the data. Registration is the process of 
aligning data using tie points from multiple scan positions. See also “Capturing Target Scans and Creating Tie 
Points”. 

To register tie points: 
1.  Set the navigation to the cube (3D) mode. (View Navigation Cube). 
2.  Load the scan data from both scan positions into the same view, and color each scan position by layer, so you 

can easily see that the data from the two scan positions are not aligned. See also “Layer”. 

 
Figure 12-1. Two (Unaligned) Scan Positions 

3.  Dock the scan positions next to each other, so you can view the data from both scan positions at the same 
time. 

 
Figure 12-2. Scan Positions Docked Next to Each Other 
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4.  To begin matching up tie points, click Select Mode Object and choose the Point Selection  tool on the 
Select toolbar. 

5.  Select the tie point from Scan Position 01, and then hold down the Shift key and select the corresponding tie 
point in Scan Position 02.  
These are the same points even though their coordinates are different.  

6.  Click Create Tie Point Constraint or click the Create Tie Point Constraint  icon on the Create 
toolbar to link the two selected tie points together.  
A new tie point constraint appears in the Tie Point Constraint folder in the Project Explorer.    

 

A tie point constraint can have as many scan 
positions associated with it as you want. 

 

Tie Points for Each
Scan Position

Tie Point
Constraints

 
Figure 12-3. Project Explorer 

7.  Repeat Steps 5 and 6 for each tie point.  
 

At least three distinct pairs of tie points are 
required to register two scan positions together. 
More tie points improve the quality of the 
registration.  

 
8.  Once the tie points have been linked, click Tools Registration Manager to begin aligning the data.  

The Registration window appears. This lists non-registered scan positions in the left panel and registered 
scan positions in the right panel. 

 
Figure 12-4. Registration Manager 

9.  Make sure Tie Point Constraints at the bottom of the window is selected.  
10.  Select the scan positions you want to register from the list in the left panel. Hold down the Shift key to select 

multiple scan positions.  
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11.  Click the right-pointing  arrow.  
A confirmation window appears, stating the registration is complete. 

 
Figure 12-5. Registration Confirmation 

12.  Click OK.  
13.  In the Viewer Window, click the Global tab.  

The scan positions have distinct alignments.  

 

Checking Registration Quality 
You can check the overall accuracy of the registration down to the individual tie point with the highest error. If 
you are not satisfied with the results, try doing the following: 

•  Rerunning the Registration 
•  Disabling a Tie Point  

To check the quality of the overall registration:  
1.  Select a scan position in the Project Explorer. 
2.  Click View Windows Object Properties.  

In this window, you can view the following information: 
•  Select a scan position in the Project Explorer, and all of the rotation, scale, and translation for the scan 

position appear in the Object Properties window in the Transformation folder.  
•  Select a scan position in the Project Explorer, and all of the tie points listed for that scan position appear 

in the Object Properties window in the Tie Points folder. This folder also shows the maximum and mean 
(average) error for all of the tie points.  

•  Select an individual tie point constraint in the Project Explorer, and the maximum and mean errors for this 
constraint appear in the Object Properties window in the Tie Points folder.  

•  Select an individual tie point in the Project Explorer, and the tie point constraint error is listed in the 
Object Properties window in the Tie Point Constraint folder. 
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Rerunning the Registration 
To rerun the registration: 

1.  Click Tools Registration Manager to open the Registration Manager. 
2.  In the right panel, select the scan positions you want to reregister, and click the left-pointing  arrow to 

move the selected scan positions to the left panel for non-registered scan positions.  
3.  Make sure Tie Point Constraints at the bottom of the window is selected. 
4.  In the left panel, select the scan positions you want to register and click the right-pointing  arrow to move 

them back to the right panel and rerun the registration. 
A confirmation window appears.  

5.  Click OK. 

Disabling a Tie Point 
To disable a tie point or constraint, select it in the Project Explorer and then set its active status from True to 
False in the Object Properties window in the Registration folder. The object you selected will not be used in 
registration. See also Checking Registration Quality.  

 

Remember to have at least three distinct tie points 
in order to register two scan positions. 

 

Associating Tie Point Constraints 
You can create a tie point constraint without selecting tie points, but you would have to make the associations 
between a tie point and tie point constraint manually.  
To associate tie point constraints: 
1.  Click Create Tie Point Constraint.  

A new tie point constraint appears in the Tie Point Constraint folder in the Project Explorer. 
2.  Select the tie points to which you want to associate a constraint. 
3.  In the Point Constraint folder in the Object Properties window (View Windows Object Properties), 

click the Constraint drop-down arrow and select a constraint from the list to which the tie points will be 
associated. 

Georeferencing 
Georeferencing brings together data from different sources. It is an additional step you can take while registering 
your data to reorient the results of the registration into a global coordinate system, such as the State Plane 
Coordinate System (SPCS). For example, if you are using a combination of a laser scanner and another instrument, 
such as a GPS or a total station, to obtain control information in the SPCS on the different targets you used during 
laser scanning, then you will want to reorient the results of your registration into that state plane.  

Georeference Registration 
Georeferencing enables you to reorient the entire dataset to correspond the coordinates of the tie point constraints 
measured using a GPS or total station with the coordinates from a laser scanner.  
To do this: 
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1.  Make sure the control coordinates are entered on an ASCII text file, which you will later import into 
ScanMaster. 

Tie Point
Coordinates

Column Headers

 
Figure 12-6. Text File with Column Headers, Point Names, and Coordinates 

2.  Follow the standard procedure for tie-point registration. See Registering Tie Points. 
3.  Import the control coordinates into ScanMaster by clicking File Import. 

The Import dialog box appears. 
 

 
Figure 12-7. Import Dialog Box 

4.  Locate the text file of the control coordinates you want to import, and click Open. 
The Import Text File dialog box appears, displaying the content of the text file. 

 
Figure 12-8. The Text File (Left) is Displayed in the Import Text File Dialog Box 

5.  In the Separator drop-down menu, select an appropriate separator. For example, select Commas from the 
drop-down menu if the control coordinates in the text file are separated by commas. See The Text File (Left) 
is Displayed in the Import Text File Dialog Box.  
Once the appropriate separator is selected, the columns in the dialog box update from text file to spread sheet 
format. 
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Figure 12-9. Comma-Separated Text File 

6.  In the Import column, choose which lines in the file to import. A check mark indicates the line will be 
imported. Click to clear the check boxes of the lines you do not want to import.  

7.  Click on each column header and select column identifier from the drop-down menu.  
In Selecting a Column Description, for example, the first column represents the point name, so you would 
select Name or choose not to use it by selecting None. 

 
Figure 12-10. Selecting a Column Description 

8.  If a name already exists in the project, choose an option in the Duplicate Name Action drop-down menu. 
9.  When you have finished, click OK, and then click OK again when the confirmation window appears. 

The points appear in the Primitives Points folder in the Project Explorer. 
10.  In the Project Explorer, make sure the check boxes next to the points you imported are selected, so the points 

are visible in the Viewer Window. 
11.  Associate the imported points to their corresponding tie point constraints. To do this: 

1.  Select a tie point constraint.  
2.  Open the Object Properties window (View Windows Object Properties).  
3.  In the Georeference folder, select the corresponding point you imported from the Georeference 

drop-down menu. SeeObject Properties Window - Georeferencing. 

 
Figure 12-11. Object Properties Window - Georeferencing 
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4.  Select another tie point constraint and associate the corresponding imported point to it using the 
Georeference drop-down menu. 

5.  Repeat Step 4 until all imported points are associated to tie point constraints.  
 

12. Click Tools Registration Manager.  
The Registration Manager appears, displaying the registered scan positioins. 

 
Figure 12-12.  

13.Unregister the scan positions by selecting all of the scan positions in the registered panel and clicking the 
left-pointing arrow to move the scan positions into the opposite panel.  

 

Hold down the Shift key to select multiple scan 
positions. 

 
14.Select all of the scan positions in the Not Registered Scan Positions panel and reregister them by clicking the 

right-pointing arrow.  
A confirmation window appears, stating the registration is complete. 

 
Figure 12-13. Registration Confirmation 

15.Click OK.  
The scan positions and imported points become aligned.  

Checking Georeferencing Quality 
You can check the overall accuracy of the georeferencing for each tie point constraint. To do this, right-click on 
the Tie Point Constraint folder in the Project Explorer and select Table from the shortcut menu. 

The Tie Point Constraints Table appears. For each georeference constraint, you can see the error to the global 
coordinates of that constraint. 

 
Figure 12-14. Tie Point Constraints Table 
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Occupation and Backsight Registration 
Occupation and backsight registration is possible because the GLS-1000 laser scanner is a dual-axis tilt instrument, 
just like a total station.  
To register occupation and backsight points: 
1.  Make sure the occupation and backsight coordinates are entered on an ASCII text file, which you will later 

import into ScanMaster. 

Occupation and
Backsight Coordinates

Column Headers

 
Figure 12-15. Text File with Column Headers, Point Names, and Coordinates 

2.  Measure the height of the GLS-1000 from the Instrument Center Mark to the ground. 
3.  In the Project Explorer, select the scan position and open the Object Properties window 

(View Windows Object Properties). 
4.  In the Object Properties window, enter the height value into the Instrument Height field in the Occupation 

folder. See Object Properties - Instrument Height. 

 
Figure 12-16. Object Properties - Instrument Height 

5.  Import the backsight and occupation coordinates into ScanMaster by clicking File Import. 
The Import dialog box appears. 

 
Figure 12-17. Import Dialog Box 

6.  Locate the coordinates text file, and click Open. 
The Import Text File dialog box appears, displaying the content of the text file. 
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Figure 12-18. The Text File (Left) is Displayed in the Import Text File Dialog Box 

7.  In the Separator drop-down menu, select an appropriate separator. For example, select Commas from the 
drop-down menu if the control coordinates in the text file are separated by commas. See The Text File (Left) 
is Displayed in the Import Text File Dialog Box. 
Once the appropriate separator is selected, the columns in the dialog box update from text file to spread sheet 
format. 

 
Figure 12-19. Comma-Separated Text File 

8.  In the Import column, choose which lines in the file to import. A check mark indicates the line will be 
imported. Click to clear the check boxes of the lines you do not want to import.  

9.  Click on each column header and select a column identifier from the drop-down menu.  
In Selecting a Column Description, for example, the first column represents the point name, so you would 
select Name or choose not to use it by selecting None. 

 
Figure 12-20. Selecting a Column Description 

10.  If a name already exists in the project, choose an option in the Duplicate Name Action drop-down menu. 
11.  When you have finished, click OK, and then click OK again when the confirmation window appears. 

The points appear in the Primitives Points folder in the Project Explorer. 
12.  In the Project Explorer, right-click on the scan position and select Properties.  

The Object Properties window appears. 
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Figure 12-21. Object Properties - Occupation 

13.   In the Occupation folder, select the occupation point from the Occupation drop-down menu. See Object 
Properties - Occupation. 

14.  In the Backsight folder, select the backsight point from the Backsight-Global drop-down menu. 
15.  In the Backsight-Local drop-down menu, select the tie point that represents the scan of the backsight. 
16.  Click Tools Registration Manager. 

The Registration Manager tab or window appears. 

 
Figure 12-22. Registration Manager 

17.  In the Registration Manager, do the following: 

1.  Select the Occupation And Backsight option at the bottom of the Registration Manager. See 
Registration Manager. 

2.  Select the scan position in the left (not registered) pane. 
3.  Click the right-pointing arrow to begin the registration process.  

Once the registration is completed, the backsight tie point becomes aligned. 
18.  Verify the scan position is offset above the occupation point by the instrument height. To do this: 

1.  Create a new distance measurement between the scan position and the ground occupation point by 
clicking Create Distance and following the instructions in the lower left side of the window. 

2.  In the Project Explorer, right-click on the distance and select Properties from the shortcut menu. 
The Object Properties window updates or appears. 

3.  In the General folder, the vertical distance should be the same value as the instrument height, which 
you previously entered. 

Checking the Occupation and Backsight Quality 
Update the Object Properties window by selecting the scan position in the Project Explorer. In the Object 
Properties window, the backsight error and occupation error are listed. 
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Chapter12 
Clouds and Meshes 

This chapter explains how to create a triangulated mesh model from point clouds and also includes instructions for 
coloring the mesh, snapping primitives to it, and resampling it to reduce redundancy. 
This chapter includes the following: 

•  Clouds 
•  Meshes 

Clouds 
There are two object types inside a project that are capable of storing laser scan data points: cloud object and scan 
object. 
A scan object is typically collected in the field with a laser scanner. A scan object always stores its data 
measurements in the local coordinate system of the scan position from which that scan was taken. 

A cloud object always stores its data measurements in the global coordinate system of the project. It is typically 
created in the office after all of the scan positions have been registered into the global coordinate system. A cloud 
object can contain data that came from multiple scan objects. 

Creating a Point Cloud  
There are several reasons for creating point clouds:  

•  A single cloud object is easier to work with in ScanMaster than multiple scan objects.   
•  There is a performance benefit from creating a cloud, because all points inside a point cloud are stored inside 

the same database on your computer’s hard drive. For example: if you have multiple scans loaded into a view, 
then ScanMaster has to process commands against the database for each individual scan. Although there are 
more points in a point cloud, commands are executed more quickly because ScanMaster only needs to process 
a single dataset. 

•  Point clouds provide the ability to focus on a small area. 
•  Point cloud resampling can reduce data redundancy. 
•  A single point cloud is easier to export than data from each scan position. 

All point clouds are stored in the Project Explorer under the Data folder. 
To create a cloud: 
1.  Select all of the data points you want to add to the cloud by clicking Select Mode Data, and then using the 

Rectangle icon or Polygon tool on the Select menu to choose the points in the Viewer Window you want to 
include in the cloud. In All Points are Selected , all of the points were selected by clicking Select All.   
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Figure 13-1. All Points are Selected  

2.  Click Create Cloud or click the Create Cloud  icon on the Create toolbar.  
ScanMaster takes a minute to create the new cloud object, which appears in the Data Clouds folder in the 
Project Explorer. 

 
Figure 13-2. Project Explorer - New Point Cloud 

3.  To check the cloud point count, right-click on the cloud in the Project Explorer and select Properties from the 
shortcut menu.  
The Object Properties window appears, listing the point count in the Data folder. 
In All Points are Selected where all of the points of the two scan positions were selected to create a cloud, the 
cloud point count is the sum of both scan positions.  

4.  To create a point cloud within a point cloud in order to focus on a small area, select the point cloud using the 
Project Explorer and then select the area you want to focus on. Click Create Cloud. 

 
Figure 13-3. A Second Point Cloud Appears in the Data Folder 

5.  To display only one point cloud at a time, select the check box of the cloud you want to display and click to 
clear the check boxes of the clouds you do not want to show. This creates a much smaller dataset that is easier 
to work with.  
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Reducing Data Redundancy 
In laser scan data, there are three sources of data redundancy: 

•  Data is redundant in areas closer to the scanner, because in those areas the point density is significantly higher 
than in areas further away from the scanner.  

•  Data is redundant in areas where two or more scans overlap, because those areas have a greater point density.  
•  Data is redundant in flat areas of the scan, because flat areas do not need as many points to be represented as 

opposed to intricate areas. 

Resampling 
Cloud resampling can address the first two sources of redundancy by equalizing point density throughout in the 
entire point cloud. 
To reduce data redundancy in a project:  
1.  Select the cloud object in the Project Explorer. 
2.  Click Edit Resample. 

The Resample window opens.  
3.  Modify the target point density as needed, and then click OK.  

After a few seconds, ScanMaster creates a new dataset in which it selects only the points that are required to 
reach the target density. 

Hiding Cloud and Scan Points 
Hiding points helps you focus on a specified area of the scan or cloud, so you can work with it more closely. 
Hidden points are not saved when the project is closed, and they only appear hidden in the current view, which 
means the hidden points are visible in other views. 

To hide points from the dataset: 
1.  Make sure you are using the Data selection mode by clicking Select Mode Data or by clicking the Data 

 icon in the Select toolbar.  
2.  Select the area you want to hide or focus on by clicking either the Rectangle Selection  icon or Polygon 

Selection  icon on the Select toolbar. These commands also appear in the Select menu.  

 
Figure 13-4. Rectangle Selection Tool 

3.  Click Select Invert. 
This command switches the selection area, so the points that are not currently selected become selected and 
vise versa. 
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Figure 13-5. Invert Selection 

4.  Click Data Hide or the Hide Data  icon on the Data toolbar to hide the selected points.  

 
Figure 13-6. Selected Points Hidden 

 

You cannot select the hidden points or snap to 
them with the polyline command.  

Figure 13-6.   

Although the selected points are hidden in the current view, they are not hidden in other views, as shown in  Two 
Views. This allows you to focus on a different region of view. 

 
Figure 13-7.  Two Views 
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Showing Cloud and Scan Points 
If you want to expand your focus to another dataset or you no longer want to hide points, then you can show 
hidden points. 

To show all hidden points, click Data Show All. 
To show additional hidden points: 
1.  If the points are hidden, click Data Display Hidden. 

The hidden points appear in blue. To change this color, see “Program Options Window”. 

 
Figure 13-8. Hidden Points are Displayed in Blue 

2.  Click either the Rectangle Selection  icon or Polygon Selection  icon on the Select toolbar to make an 
additional selection. These commands also appear in the Select menu. 

Additional
Selection

 
Figure 13-9. Additional Selection 

3.  Click Data Show, and then click Data Display Hidden. 
The Viewer Window only shows the expanded selection. 

 
Figure 13-10. Showing Expanded Selection 

 

If the selected data is still highlighted in yellow, 
click Select None. 
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Deleting Cloud and Scan Points 
Use the Delete command to permanently remove points from the dataset. Unlike the Hide command, the delete 
action can be saved, so if you close the project and open it again, the deleted points will still be deleted. And, if 
you delete points in one view, the same points will be deleted in other project views. This is useful for removing 
erroneous points. See also Restoring Deleted Points. 

To delete points from the dataset: 
1.  Make sure you are using the Data selection mode by clicking Select Mode Data or by clicking the Data 

 icon in the Select toolbar.  
2.  Select the area you want to delete by clicking either the Rectangle Selection  icon or Polygon Selection 

 icon on the Select toolbar. These commands also appear in the Select menu. 

 
Figure 13-11. Points Selected (Yellow) 

3.  Click Data Delete or click the Delete Data  icon on the Data toolbar. 
After a few seconds, the deleted points are removed from the current view and other project views, as shown 
in  Deleted Points are Removed from All Project Views. 

 
Figure 13-12.  Deleted Points are Removed from All Project Views 

 

Restoring Deleted Points 
Use the Restore command to recover deleted points. This enables you to delete points without fear of making a 
mistake and losing raw data. 

To restore all deleted points, click Data Restore All. 
To restore sections of deleted points, but not all of them:  

1.  Click Data Display Deleted or click the Data Display  icon on the Data toolbar and select Deleted 
 from the drop-down menu.    

The deleted points are colored red. 
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Figure 13-13. Deleted Points (Red) 

2.  To restore the deleted points, select a portion of the deleted region.  
To make a selection: 

1.  Make sure you are using the Data selection mode by clicking Select Mode Data or by clicking 
the Data  icon in the Select toolbar.  

2.  Click either the Rectangle Selection  icon or Polygon Selection  icon on the Select toolbar. 
These commands also appear in the Select menu.  

The selection is colored in yellow.  

 
Figure 13-14. Selected Deleted Points 

3.  Click Data Restore or click the Restore Data  icon on the Data toolbar. 

 
Figure 13-15. The Selected Deleted Points are Restored 

Purging Deleted Points 
To permanently purge deleted points from a scan or cloud object: 
1.  Select a region of the scan and delete the selected region.   
2.  Click Edit Purge Deleted. 

A confirmation window appears. 
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Figure 13-16. Purge Deleted Points Confirmation Window 

3.  Click Yes to remove the deleted points from the dataset. 

Recovering Purged Points 
The Purge Deleted command is available for both cloud and scan points. It is possible, however, to recover purged 
scan points but not purged cloud points. This is because there is a backup of the raw scan file stored in the project. 
If you make a mistake and purge deleted cloud points, then you will have to remake the point cloud from scans 
you originally used to create it. 

To recover purged points: 
1.  Select the scan object in the Project Explorer. 
2.  Click Edit Recover Deleted.  

The scan dataset appears from the raw backup file with all of the points in it.  

Occlude Overlapped Points 
Click and set to “ON” from Menu->Data->Occlude, then points in the far side are non-displayed among the points 
overlap displayed in near side and the far side from view point. 

Exporting Point Clouds 
You can export data from ScanMaster to another program by right-clicking on the single point cloud in the Project 
Explorer and selecting Export from the shortcut menu. For more information, see “Exporting Scans and Images”. 

Showing More Points in a Point Cloud 
Every time you load a point cloud, all points are loaded into memory and are processed; however, not all points 
are shown on the screen at the same time to optimize performance. While the view is manipulated, the Viewer 
Window refreshes at a quick rate of approximately 30 frames per second, which is similar to movies or television. 
This is why ScanMaster does not automatically display all points.  

To show more points: 
Click Menu->data->“Increase Point Density” or “Decrease Point Density” in Tool bar. Then display higher or 
lower point resolution. Furthermore, it can change display size of by click “Increase Point Size” and 
“Decrease Point Size”. 
The higher resolution, the longer it takes the screen to refresh. ScanMaster rebuilds at the value you entered. 
In order to efficiently store, process, and display the points, it has to maintain a minimum level of resolution. 
If you set a value that is too great, it will try to approach the value you entered as much as possible. If you set 
a lower value, then the data becomes denser, however, it takes extra time and memory to display all of the 
points on the screen. For this reason, you do not want to operate at a higher resolution than you need. 

Resample Dynamic and Resample Static 
These options are applied on top of the display resolution and can adjust the level of display to preserve a high 
degree of performance. They adjust the resolution dynamically without rebuilding the dataset. 
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To use these options: 
1.  Open the Options window (Tools Options). 
2.  In the Data folder, click Resample-Dynamic to display the drop-down menu, and then select an option: None, 

Low, Medium, and High.  
The dynamic option applies when the camera is orbiting, panning, or zooming. If set to High, then while the 
camera is moving around, the point cloud is displayed at a low resolution to help maintain a high frame rate. 
Once you zoom in on an area, you get the full display resolution.  

3.  In the Data folder, click Resample-Static to display the drop-down menu, and then select an option: None, 
Low, Medium, and High. The static option applies when the camera/Viewer Window stays still. If set to Low, 
the point cloud gets less dense. With each level (Low, Medium, and High), approximately 1/8 of the points 
disappear from view.  

Meshes 
A mesh object is a triangulated surface that passes through a collection of data points. In a point cloud, for 
example, adjacent points in the region are linked with small triangles in a logical manner that follows the 
geometry of the surface and thereby creates a mesh. 
Meshes have many useful properties: 

•  You can color mesh objects by elevation, intensity, image color, or layer. 
•  You can snap primitives to it in between the laser scan data. 
•  You can extract sections, profiles, single sections, and contours. See also Chapter 16. 
•  You can export mesh to other engineering software. 

Creating Meshes 
Although ScanMaster is optimized to handle laser scan data, performance requirements for creating and storing 
mesh files are significantly higher than performance requirements for creating and storing laser scan points. For 
this reason, it is best to keep meshes small, within several million points, and you should not try to create meshes 
as big as your entire laser scan dataset. 
To create a mesh: 
1.  Select a region of the point cloud. To do this, click Select Mode Data and then choose either Rectangle or 

Polygon tool in the Select menu. 

Selected
Points

 
Figure 13-17. The Selected Mesh Appears in Yellow Below the Existing Mesh 

2.  Once an area is selected, orient the view so you are looking at the front of what you expect the mesh surface to 
be. To do this, you can do one of the following: 

•  If you know all of your data came from a single scan position, then you can switch to the spherical view. 
This ensures the correct geometry of the surface. Click View Navigation Sphere.  

•  Rotate the view by clicking and holding the left mouse button, and then moving the pointer in the 
direction you want to rotate the view. 
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3.  Once you have the correct orientation, click Create Mesh or click the Create Mesh  icon on the 
Options toolbar.  
Creating the mesh can take from several seconds to several minutes, depending on how many points were 
selected. 

4.  To display the mesh on the screen, select the check box next to it in the Project Explorer in the 
Data Meshes folder. All project meshes are stored in this folder. 
Polylines, points and tie-points are used to create mesh. And polylines are used as break line. 

New Mesh

 
Figure 13-18. Newly Created Mesh 

5.  To switch between wireframe and shaded mesh displays: 

1.  Open the Options window by clicking the Options tab in the lower left corner of the window or by 
clicking Tools Options.  

2.  In the Mesh folder, click Shading and then select either Solid or Wireframe. These options help you 
get a better look at the data. 

Options
Tab

Click to Display the
Shading Drop-

Down Menu

 
Figure 13-19. Options Window 

Coloring Meshes 
Mesh objects can be colored by elevation, intensity, image color, or layer.  

To do this: 
1.  Select the mesh in the Project Explorer in the Data Meshes folder. 
2.  Click Data Color, and then select an option in the submenu. 

 
Figure 13-20. Mesh Coloring Options 
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ScanMaster updates the Viewer Window according to the option you selected. For more information, see 
Chapter 9. If you selected Data Color Elevation, for example, then the Viewer Window updates as shown 
inThe Mesh is Colored According to the Elevation . 

 
Figure 13-21. The Mesh is Colored According to the Elevation  

Snapping Primitives 
You can snap primitives to a mesh surface in between the laser scan data. To do this, select an option from the 
Create menu. If you select Polyline, for example, you can digitize the polyline in between the vertices of the 
original laser set. Each point selected (Follow the selection instruction in the lower left corner of the window.) is 
interpolated along the triangular surface between the laser scan data points.  

Resampling Mesh 
Resampling reduces the point count and enables you to export the mesh to other engineering software. An 
interesting property of mesh resampling is that it intelligently removes points from the flat areas before it removes 
them alongside any breakline that may exist. This way, you can eliminate points in the dataset while preserving 
model accuracy.  
To resample the mesh: 
1.  Select the mesh in the Project Explorer in the Data Meshes folder. 
2.  Click Edit Resample. ScanMaster takes a few seconds to prepare the mesh for resampling, depending on 

how many points were in the original mesh. After the preparation phase is complete, the Resample Mesh 
window appears. 

 
Figure 13-22. Resample Mesh 

In this window, you are shown the current number of points, which is listed as the maximum number, and the 
minimum number of points.  

3.  Adjust the slider to the left to reduce the current number of points. As the slider moves, the triangles begin 
disappearing from the mesh, and the image is automatically updated. 

4.  Click Finish to create a new mesh. 

Exporting Mesh 
You can export a mesh from ScanMaster to another program by right-clicking on the mesh name you want to 
export in the Project Explorer and selecting Export from the shortcut menu. 
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Chapter13 
Primitives 

You can add simple geometric objects (primitives), such as points, planes, and polylines, to your data. 

This chapter includes the following: 
•  Planes 
•  Points 
•  Polylines 

Planes 
A plane primitive is a rectangle floating in 3D space. A plane has a certain position and orientation in 3D. It also 
has a certain length and width associated with it. 

 
Figure 14-1. Plane 

 

Snapping to Planes 
A useful feature of a plane is that you can snap a primitive, such as points and polylines, to the plane instead of the 
actual scan data points. This is especially useful in regions that you know are planar, such as a building wall, but 
where you don’t have enough data to accurately digitize on top of the laser scan.  

For example, if you click Create Polyline and try to digitize the polyline in the region where you don’t have 
enough data, you cannot create any points in the polyline in between the scan line. In a region where you have the 
plane object, the polyline snaps to the plane in between the scan data.  

Creating a Plane 
To create a plane: 

1.  Select one or more data points from the laser scan. To do this, click Select Mode Data. 
2.  Choose the Rectangle or Polygon tool from the Select menu to make a selection. Directions for using these 

tools appear on the lower left corner of the window. 
3.  Click Create Plane or click the Fit Plane  icon on the Create toolbar to populate the selection. 

This plane object is calculated using the least square fit technique to the selected points. That means despite 
the minute noise between the adjoining data points, it produces the best possible fit for the surface that the 
points are supposed to represent. 
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Points 
A point primitive is similar to a survey point, sharing many of the same attributes, such as a point name; X,Y, and 
Z coordinates; and a description. The difference is that a survey point is typically collected in the field with a 
sensor, such as a GPS receiver or a total station. A point primitive is digitized on top of the laser scan data on an 
office computer. A list of the point primitives is in the Project Explorer Primitives Points folder. 

 
Figure 14-2. Project Explorer - Point Primitives 

Creating a Point 
To create a point primitive: 

1.  Click Create Point or click the Draw Point  icon on the Create toolbar. 
2.  Ctrl+click anywhere on the data to create points. These instructions also appear in the prompt line in the lower 

left corner of the window. 

 
Figure 14-3. The Points Appear as Red Circles as They are Created 

3.  If you release the Ctrl key, then you can freely reposition your view to another location, and then press 
Ctrl+click again to add more points. 

4.  Ctrl+(right-click) to end the routine. 

Editing Points 
The only editing command that applies to a point primitive is the Set Position command. This enables you to 
reposition a point. 

To do this: 
1.  Select the point, and click Edit Set Position.  
2.  Ctrl+click on the position in which you want to relocate the point. The point moves to the new position. These 

instructions also appear in the prompt line in the lower left corner of the window. 
3.  Ctrl+(right-click) to end the routine. 
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Polylines 
A polyline is a collection of vertices linked in order by linear line segments. The vertices are denoted by the blue 
square grip points, and each consecutive pair of vertices is linked by a yellow linear line segment. The Project 
Explorer displays a list of all polylines. 

Creating Polylines 
To create a polyline: 

1.  Click Create Polyline or click the Draw Polyline  icon on the Create toolbar. 
2.  Ctrl+click anywhere on the data to begin the creation process. These instructions also appear in the prompt 

line in the lower left corner of the window. 

 
Figure 14-4. The Polyline Vertices Appear in Red as They are Created 

3.  If you release the Ctrl key, then you can freely reposition your view to another location, and then press 
Ctrl+click again to add vertices to the end of the polyline. 

4.  Ctrl+(right-click) to end the routine. 

Editing a Polyline Vertex 
Select any vertex of the polyline, and then open the Edit menu for a list of commands that apply to that vertex.  

Deleting a Vertex 
To delete a vertex: 
1.  Make sure ScanMaster is in the object selection mode (Select Mode Object), and then select the polyline 

using the Point Selection  tool from the Select menu or toolbar. 

 
Figure 14-5. The Vertices of the Selected Polyline Become Visible 

2.  Click to select a blue grip square at the beginning of the vertex you want to delete. The square turns red. See 
The Blue Grip Square Turns Red, Indicating the Following Vertex is Se. 
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Figure 14-6. The Blue Grip Square Turns Red, Indicating the Following Vertex is Selected 

3.  Click Edit Delete.  
A confirmation window appears. 

 
Figure 14-7. Confirmation Window 

4.  Click Yes. 
The vertex disappears from the view. 

 
Figure 14-8. Vertex Deleted 
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Repositioning a Vertex 
To reposition a vertex: 
1.  Make sure ScanMaster is in the object selection mode (Select Mode Object), and then select the polyline 

using the Point Selection  tool from the Select menu or toolbar. 

 
Figure 14-9. The Vertices of the Selected Polyline Become Visible 

2.  Click to select a blue grip square at the beginning of the vertex you want to reposition.  
The square turns red. See The Vertex was Repositioned Across the Top of the Building. 

3.  Click Edit Set Position.  
4.  Ctrl+click anywhere on the scan data to reposition the vertex as necessary.  

These instructions also appear in the prompt line in the lower left corner of the window.  

 
Figure 14-10. The Vertex was Repositioned Across the Top of the Building 

5.  Ctrl+(right-click) to end the routine. 

Adding/Appending Vertices 
To add a vertex to the end of a polyline: 
1.  Select the Polyline by doing one of the following:  

•  Clicking on the name of the polyline in the Project Explorer. 
•  Making sure ScanMaster is in the object selection mode (Select Mode Object), and then selecting the 

polyline using the Point Selection  tool from the Select menu or toolbar. 
2.  Click Edit Append Vertex. 
3.  Ctrl+click anywhere on the scan data to position the additional vertex as necessary. The additional vertex 

appears at the end of the polyline. 
4.  Ctrl+(right-click) to end the routine. 

To add a vertex to the beginning of a polyline: 
If you want to add a vertex to the beginning of the polyline, then you need to reverse the order of the vertices.  
1.  Select the polyline. 
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2.  Click Edit Reverse. 
ScanMaster reorders the vertices from last to first as shown in the Vertices-Polyline table inReversed Order. 
See alsoUsing the Vertices Table. 

Before

After

 
Figure 14-11. Reversed Order 

3.  Click Edit Append Vertex. 
4.  Ctrl+click anywhere on the scan data to position the additional vertex as necessary.  

The additional vertex appears at the end of the polyline. 
5.  Ctrl+(right-click) to end the routine. 
6.  If you want to change the order again, once you have finished, click the Order column header.  

ScanMaster changes the number sequence. 

Inserting Vertices 
To insert a vertex: 
1.  Select the polyline. 
2.  Click to select a blue grip square you want to precede the inserted vertex. 
3.  Click Edit Insert Vertex. 
4.  Ctrl+click anywhere on the scan data to insert the vertex.  

The inserted vertex appears after the blue grip square you selected. 
5.  Ctrl+(right-click) to end the routine. 

Closing Polylines 
To close a polyline: 
1.  Select the polyline. 
2.  Open the Polyline table by right-clicking and selecting Table from the shortcut menu or by clicking 

Edit Table. 

 
Figure 14-12. Polyline Shortcut Menu 
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3.  In the Polyline Table, select the polyline you want to close, and then select the Closed check box. ScanMaster 
closes the polyline. 

Open Polyline Closed Polyline

 
Figure 14-13. Open and Closed Polylines 

Using the Vertices Table 
The Vertices Table enables you to enter new coordinate values, reorder the sequence, change type of vertex(Arc 
start, Arc end, Rectangle, Close), and see object associations (snapped) to other primitives. If a vertex is 
associated to (snapped to) another object, such as a point primitive, and that object is moved, then the polyline 
automatically updates to the new position. 

Reordering Vertices 

 
To see a list of all of the vertices in the polyline, so you can reorder them: 
1.  In the Project Explorer, select the polyline and click Edit Vertex Table.  

The Vertices Table appears. 

 
Figure 14-14.  Vertices Table 

2.  In the Order column, use the up and down arrows to select a new number (order) sequence for the rows you 
want to change.  
ScanMaster immediately updates the Viewer Window with the new order. 
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Figure 14-15. Vertices - Reordered 
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Chapter14 
Measurements 

This chapter includes the following: 

•  Angle Measurements 
•  Distance Measurements 

Angle Measurements 
An angle measurement is the interior or exterior angle between any three points on the laser scan dataset. See 
Angle Measurement 

 
Figure 15-1. Angle Measurement 

Creating Angle Measurements 
To create an angle measurement:  

1.  Click Create Angle or click the Measure Angle  icon on the Create toolbar.  
2.  Press and hold Ctrl, and click anywhere on the laser scan to select an angle measurement point. (These 

instructions also appear in the lower left corner of the window). 
3.  Repeat Step 2 to select the second and third points. You can release the Ctrl key to move the laser scan 

around for a better sense of where you want to place a point. 
Once the third point is selected, the angle measurement is automatically created. 

 
Figure 15-2. New Angle Measurement in Red 

4.  Press Ctrl+(right-click) to end the point selection process. 
To check the azimuth, zenith, and slope angles of the measurement you just created: 
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1.  In the Project Explorer, right-click on the angle measurement and select Properties from the shortcut menu. 
OR 

1.  Select the angle measurement by clicking on it in the Project Explorer. 
2.  Open the Object Properties window by clicking View Windows Object Properties.  

The Object Properties window opens, listing all of the important attributes of an angle measurement, 
including the three points selected and the azimuth, zenith, and slope angles between them. 

 
Figure 15-3. Object Properties - Measurement Folder 

Repositioning a Measurement Point 
You can reposition one or more of the points that compose an angle measurement.  

To do this: 

1.  Make sure the Object mode is selected by clicking Select Mode Object or by clicking the Object  
icon on the Select toolbar. 

2.  Use the Point Selection  tool on the Select toolbar (or click Select Point) to select the angle 
measurement, and then click on an end point.  

3.  Click Edit Set Position.  
4.  Press and hold Ctrl and click anywhere on the laser scan to select a new angle measurement point. (These 

instructions also appear in the lower left corner of the window). 
5.  Press Ctrl+(right-click) to end the point selection process. 

Editing an Angle Measurement 
You can edit the display settings for an angle measurement in the Display folder of the Object Properties window. 

 
Figure 15-4. Angle Measurement Display Settings 

To edit any of the Display values, click on the field you want to edit and either enter a new value or make a 
selection from the drop-down menu. These settings are:  

•  Layer: This displays the layer on which the angle is placed. The layer settings are applied to the angle. To 
change the layer, click on the layer name and select another from the drop-down menu. To view or change the 
layer settings, click View Tables Layers. See also “Using the Layer Table”. 

•  Offset: This offsets the angle measurement by an amount (the value you enter) from the selected points. Click 
in this field and enter an offset value. For example, if you change the value of the offset to 1 inch, then the 
offset moves outward one inch from the points you selected. To move the offset in the opposite direction, 
enter a negative value. 
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•  Radius: This controls the radius of the circular arrow leader inside the angle measurement. Click in this field 
and enter a value. The arrow leader increases or decreases in size, depending on the value you entered. To 
switch the leader from the interior of the angle measurement to the exterior, enter a negative value. 

•  Style: This controls the angle of the leader between the selected points. Click in this field and select an angle 
type from the drop-down menu: slope, horizontal, or vertical. 

Snapping Angle Measurements 
When measuring angles, it is recommended to snap them to existing point primitives. This technique is useful 
when you need to annotate multiple angles between the same set of points. Snapping to an existing point primitive 
always ensures that the angle measurement goes to the same set of points.  

To do this: 
1.  Click Create Angle or click the Measure Angle  icon on the Create toolbar.  
2.  Press Ctrl and click existing point primitives to create an angle measurement.  

Once the third point primitive is selected, the angle measurement leader appears. 
3.  Press Ctrl+(right-click) to end the point selection process. 

In the future, if the position of one of these points changes, the angle measurement automatically updates to 
reflect the change.  

Distance Measurements 
This is the measurement of distance between two points on the laser scan data. You can find all of the distances in 
the project in the Project Explorer in the Measurements Distances folder. 

 
Figure 15-5. Distance Measurement 

Creating Distance Measurements 
To create a distance measurement:  
1.  Click Create Distance or click the Measure Distance  icon on the Create toolbar.  
2.  Press and hold Ctrl and click anywhere on the laser scan to select the starting distance measurement point. 

(These instructions also appear in the lower left corner of the window). 
3.  Repeat Step 2 to select the end point. You can release the Ctrl key to move the laser scan around for a better 

sense of where you want to place the point.  
Once the end point is selected, a 3D leader between the two points appears. 
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Figure 15-6. New Distance Measurement in Red 

4.  Press Ctrl+(right-click) to end the point selection process. 
To check the distance between the points: 
1.  In the Project Explorer, right-click on the angle measurement and select Properties from the shortcut menu. 

OR Select the distance measurement by selecting it in the Project Explorer. 
2.  Open the Object Properties window by clicking View Windows Object Properties.  

The Object Properties window appears, listing all of the important attributes of the distance measurement, 
including the two points selected (A and B) and the horizontal, vertical, and slope distances between them. 

 
Figure 15-7. Object Properties - Measurement Folder 

Repositioning a Distance Measurement  
You can reposition one or both of the points that compose the distance measurement.  

To do this: 

1.  Make sure the Object mode is selected by clicking Select Mode Object or by clicking the Object  
icon on the Select toolbar. 

2.  Use the Point Selection  tool on the Select toolbar (or click Select Point) to select the distance 
measurement, and then click on an end point.  

3.  Click Edit Set Position.  
4.  Press and hold Ctrl and click anywhere on the laser scan to select a new distance measurement point. (These 

instructions also appear in the lower left corner of the window). 
5.  Press Ctrl+(right-click) to end the point selection process. 

Editing a Distance Measurement 
You can edit the display settings for a distance measurement in the Display folder of the Object Properties 
window. 
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Figure 15-8. Distance Measurement Display Settings 

To improve the appearance of the measurement for annotation purposes, you can edit any of the Display values. 
The most relevant settings are:  

•  Offset: This offsets the distance measurement by an amount (the value you enter) from the selected points. 
Click in this field and enter an offset value. For example, if you change the value of the offset to 1 inch, then 
the offset moves outward one inch from the points you selected. To move the offset in the opposite direction, 
enter a negative value. 

The Offset
Moves Outward
from the
Selected Points

 
Figure 15-9. Offsets 

•  Style: This controls the angle of the leader between the selected points. Click in this field and select an angle 
type from the drop-down menu: slope, horizontal, or vertical. 

Slope Horizontal Vertical

 
Figure 15-10. Display Styles 

ScanMaster automatically updates the Viewer Window with your edits. 

Snapping Distance Measurements 
When measuring distances, it is recommended to snap them to existing point primitives. This technique is useful 
when you need to annotate multiple distances between the same set of points. Snapping to an existing point 
primitive always ensure that the distance measurement goes to the same set of points.  
To do this: 
1.  Click Create Angle. 
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2.  Press Ctrl and click existing point primitives to select them and create a distance measurement.  
Once the second point primitive is selected, the distance measurement leader appears. 

3.  Press Ctrl+(right-click) to end the point selection process. 
In the future, if the position of one of these points changes, the distance measurement automatically updates to 
reflect the change.  
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Chapter15 
Annotations 

Annotations are customizable labels attached to objects inside the project.  

All project annotations are listed toward the bottom of the Project Explorer. SeeProject Annotations. 

Annotations

Annotations
List in the

Project
Explorer

 
Figure 16-1. Project Annotations 

Annotating Objects 
To annotate objects: 
1.  Select the objects. See also “Selecting Objects”. 
2.  Click Edit Annotate.  

A label appears on top of each selected object and lists all of the attributes that can be edited. See also 
Customizing Attributes.  

 
Figure 16-2. Annotating an Object 

Customizing Attributes 
When creating annotations, each annotation has all of the object attributes listed. You can customize how many 
attributes to list and in which order they appear. 

To customize attributes: 
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1.  Click Tools Annotation Styles.  
The Annotation Styles tab appears in the Viewer Window. This tab is divided into three panes: Objects, 
Styles, and Attributes. The Objects pane lists each object type in the project that can be annotated. 

 
Figure 16-3. Objects Pane 

2.  Select an object type in the Objects pane.  
 The Styles pane displays all of the available annotation styles for the object type you selected.  

Click to
add an
annotation
style

 
Figure 16-4. Styles Pane  

3.  To add an annotation style, click the Add  icon next to the Styles pane.  
A new row appears at the bottom of the list in the Styles pane. 

4.  In the new row, click in the Name field and type a new name to reflect what the style is supposed to represent. 
5.  Modify the style settings as needed. For more information about these settings, seeAttributes Field 

Definitions.   
Table 16-1. Attributes Field Definitions 

Field Definition 

Horizontal Alignment Positions the leader from the left to the right of the annotation. Choose Left, Center, or Right 
from the drop-down menu. 

Vertical Alignment Positions the leader from the top to the bottom of the annotation. Choose Top, Center, or 
Bottom from the drop-down menu. 

Position X Defines the X coordinate of the annotation. The default is 0. You can enter a different value. 

Position Y Defines the Y coordinate of the annotation. The default is 0. You can enter a different value. 

Position Type Relative: As the screen moves around, the annotation remains in a fixed position away from the 
object. 
Absolute: As the screen moves around, the annotation remains fixed in a certain position on the 
screen, and the leader increases and decreases according to the distance between the annotation 
and the object it identifies. 

 
6.  To delete an annotation style, select it and click the Delete  icon to the right of the Styles pane. 
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You cannot delete the default style. 

 
7.  To edit the attributes for a style, select the row of the style from the Styles pane. (See how the entire row is 

selected in Attributes Pane.) 
The Attributes pane displays all of the attributes of the selected style. 

 
Figure 16-5. Attributes Pane 

8.  Modify the attribute settings as necessary. For more information about these settings, seeAttributes Field 
Definitions. 

Table 16-2. Attributes Field Definitions 

Field Definition 

Attribute Shows the name of the attribute. This name does not appear in the annotation and cannot 
be changed.  

Order Lists the order (by consecutive number) in which the attribute appears in the annotation. 
To change the placement order of an attribute, do one of the following: 

•  Select the Order field of the attribute, and click the up and down arrows inside the 
field. 

•  Select the row and click the up or down arrow to the right of the Attributes pane. 

Show Indicates whether or not an attribute is displayed in the annotation. By default, a check 
mark appears in this column for all of the attributes. To hide an attribute in the annotation, 
click to clear this check box. Also, you can select all of the rows, right-click, and choose 
Hide or Show from the shortcut menu. 

Prefix Describes the type of value that is displayed. This is often the name of the attribute. The 
prefix appears in the annotation and can be changed. 

Suffix (optional) Describes additional value information, such as measurement units. For example, click a 
Suffix field and type “f” for feet or “m” for meters to describe the measurement unit.  
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Applying Annotation Styles 
To apply a new style to an annotation:  

1.  Select the annotation. You can do this by clicking on the annotation in the Project Explorer or by clicking 
Select Modes Object and then using the Point Selection tool to select the annotation.  

2.  Open the Object Properties window by clicking View Windows Object Properties. 
The Object Properties window appears. 

 A quick way to open the object properties window 
is to right-click on the object in the Project 
Explorer and then select Properties from the 
shortcut menu. 

 
3.  Under Display, click Style and select an option from the drop-down menu. 

 
Figure 16-6. Object Properties Window – Style Options 

The annotation changes according to the attributes of the style you selected. 

Positioning Annotations 
When an annotation overlaps an object, you can offset the annotation.  

To position an annotation:  
1.  Select the annotation. 
2.  Click Edit Set Position.  
3.  Press and hold the Ctrl key, and click where you want to locate the annotation, as stated in the prompt line on 

the lower left side of the window. 
A leader appears, connecting the annotation and the object. 

4.  Press Ctrl+(right-click) to end the Set Position command. 

Fixing Positions 
Annotations have two position types: Absolute and Relative.  

•  Relative: As the screen moves around, the annotation remains in a fixed position away from the object.   
•  Absolute: As the screen moves around, the annotation remains fixed in a certain position on the screen, and 

the leader increases and decreases according to the distance between the annotation and the object it identifies. 

Position types are set to Relative by default. To change the position type to Absolute: 
1.  Select the annotation. 
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2.  Click on Position Type in the Object Properties window. (If this window is not displayed, click 
View Windows Object Properties. 
A drop-down arrow appears next to the position type.  

3.  Select Absolute from the drop-down menu. 
The position type can also be fixed when setting up the annotation style. See also Customizing Attributes. 

Aligning Annotations 
By default, the annotation is attached to the center of the leader. 
To change the annotation alignment: 
1.  Select the annotation. 
2.  In the Object Properties window, click Alignment under Display. The alignment is separated into two 

options: 
•  Horizontal – Positions the leader from the left to the right of the annotation. 
•  Vertical – Positions the leader from the top to the bottom of the annotation. 

3.  Click Horizontal and select an option from the drop-down menu. The annotation moves according the setting 
you selected. 

4.  Click Vertical and select an option from the drop-down menu. The annotation moves according the setting 
you selected. 
You can also define the alignment settings in the Annotation Styles. See alsoCustomizing Attributes. 
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Chapter16 
Cross Sections 

This chapter includes the following: 

•  Profile Sets  
•  Section Sets  
•  Single Sections  
•  Contour Sets 

Profile Sets 
A profile object is a set of cross sections that follow the length of a polyline and are parallel to it. Think of a 
profile object as a polyline that has been draped onto the surface of a mesh.  

 
Figure 17-1. Polyline on Surface Mesh 

Individual profiles are organized into profile sets. A profile set represents a cross section of all of the profiles that 
run along the length of the same polyline and intersect the same mesh surfaces. SeeCross Sections. The Project 
Explorer contains a list of all of the profiles in the Cross Sections Profile Sets folder.  

 
Figure 17-2. Cross Sections 

Creating a Profile 
To create a profile: 

1.  Click Create Polyline to create a polyline along which you want to extract the profile. 
2.  Ctrl+click anywhere on the mesh data to create the vertices for the profile, and then Ctrl+(right-click) when 

you have finished. These instructions also appear in the lower left corner of the window. 
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3.  Once the polyline is created, orient the view so you are looking down on the surface from which you want to 
extract the profile. 

 
Figure 17-3. Polyline and Orientation 

4.  Select the polyline, and click Edit Extract Profile Set.  
After a few seconds, a new profile set appears in the Project Explorer, and the profile is extracted. 

5.  To see the cross sections: 

1.  In the Project Explorer, right-click on the profile set and select Table from the shortcut menu. 
2.  In the Profiles Table, select all of the check boxes in the Show Plane column. You may have to 

scroll to the right to see it. 

 
Figure 17-4. Profile Set Table - Show Plane  

As the check boxes are selected, the cross sections appear. 

Additional Information 
•  To remove all of the lines from the profile, select the profile set and then click Edit Clear. 
•  To re-extract the profile, select it and then click Edit Extract. 

Section Sets 
A section set is a set of cross sections that intersect a mesh surface along the length of a polyline. The cross 
sections intersect this polyline at a fixed interval and are always perpendicular to it. It looks similar to a contour 
set, except that instead of going through a mesh surface at a certain elevation, it follows a central polyline. All 
section sets are stored in the Project Explorer in the Cross Section Section Set folder. 
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Polyline
Cross Section

 
Figure 17-5. Section Set 

 

Creating Section Sets 
To create a section set: 
1.  Click Create Polyline to create a polyline that will serve as the center line for the section set. 
2.  Ctrl+click anywhere on the mesh surface to append the vertices to the polyline. These instructions are also in 

the lower left corner of the window. 

 
Figure 17-6. Polyline (Red) 

3.  Ctrl+(right-click) when you have finished creating the polyline. 
4.  Orient the surface so you are looking down on it. This determines the orientation of the cutting plane.  
5.  Make sure the polyline is selected, and then click Edit Extract Section Set.  

The Create Section Set dialog box appears.  

 
Figure 17-7. Create Section Set 

6.  Select or enter a Station Interval in which to extract the section. 
7.  Select or enter an Offset. This is the distance to the left and right of the polyline for which the sections will 

extend. 
8.  Click OK. 

After a few seconds, the section set is extracted. 
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Figure 17-8. Section Set (Red Lines) 

Editing Section Sets 
You can edit a section set to adjust the offset and station interval for the sections.  

 

When you change a setting, the section set is 
cleared of all the resulting line work, so you can 
make several edits at once without having to 
re-extract the cross sections after each adjustment. 

 
To do this: 
1.  In the Project Explorer, right-click on the section set you want to edit and select Properties from the shortcut 

menu. 
The Object Properties window appears. 

 
Figure 17-9. Object Properties Window 

2.  In the Dimensions folder, enter a new value for the Interval, Offset, and the Width as necessary, and then 
press Enter. 
ScanMaster updates the laser scan. 

3.  When you have finished making edits, select the section set, and then click Edit Extract to extract the new 
cross sections. 
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Single Sections 
A single section is a side plane that intersects a mesh surface. At the intersection, there is a thin polyline that 
defines the single section. Single sections have a wide range of utilities, and all single sections are stored in the 
Project Explorer in the Cross Sections Single Sections folder. 

Front View Top View

PolylineSingle
Section

 
Figure 17-10. Single Section 

Creating a Single Section 
A section can only be extracted over a mesh surface. It cannot be extracted over raw, scan, or cloud data. 

To create a single section: 
1.  Orient the view over the mesh surface in the direction in which you want to extract the single section. In many 

cases, this is the top view.  
2.  Click Create Single Section to extract the section. 
3.  Ctrl+click to select the starting point of the section, and then Ctrl+click again to select the end point. These 

instructions are also stated in the prompt line on the lower left side of the window. 
4.  Ctrl+(right-click) to end the routine. 

After a few seconds the cross section polyline is extracted. 

Polyline

 
Figure 17-11. The Cutting Plane Intersects the Surface at the Polyline 

5.  To make the single section visible:  

1.  Select the single section in the Project Explorer. 
2.  Open the Object Properties window by clicking View Windows Object Properties. 
3.  In the Display properties, click Show Plane and then select True from the adjacent drop-down menu.  
4.  Orient the view as needed to see the single section. You may also want to unselect it. 
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Figure 17-12. Oriented View of the Single Section 

Editing the Section Size 
You can change the dimensions, such as length and width, of a single section. This is useful when a section does 
not capture all of the information you are looking for.  
To edit the dimensions: 
1.  Select the single section using the Project Explorer or by using the Point Selection tool while in the object 

selection mode (Select Mode Object).  
2.  In the Object Properties window (View Windows Object Properties) in the Dimensions Size folder, 

adjust the coordinate size (length, width, and height) by entering a new value and press Enter.  
The coordinate compass in the left corner of the Viewer Window shows you which coordinate represents 
which dimension. 

 
Figure 17-13. Coordinate Compass 

 

The polyline is not extracted every time you make 
an edit, so if you make several edits, the polyline 
may disappear from view. 

 

3.  To re-extract the polyline when you are done editing the plane, select the section plane, click Edit Extract 
and then Edit Clear.  

Repositioning a Single Section 
To reposition the section: 

1.  Select the plane.  
2.  Use the Point Selection tool to select the center point of the plane. 
3.  Click Edit Set Position. 
4.  Ctrl+click to reposition the center point. The plane automatically repositions to the point you selected. 
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5.  Ctrl+(right-click) when you have finished.  

Contour Sets 
A contour is a cross section through a meshed surface that runs parallel to the ground at a certain elevation. 

All contours are listed in the Project Explorer Cross Sections Contours Sets folder. Contours are organized 
into contour sets. Contour sets are a collection of contours that run through the same set of surfaces at the same 
interval. 

Creating Contour Sets 
To create a contour set: 
1.  Select the Contour Set folder in the Project Explorer. 
2.  Click Edit Extract Contour Set.  

The Extract Contour Set dialog box appears. 

 
Figure 17-14. Extract Contour Set 

3.  Enter or select the minimum and maximum elevation through which contours should run.  
4.  Enter or select the elevation interval. 

ScanMaster extracts the contours. After the contouring process is complete, the individual contours appear on 
the screen. You can assign each contour to an individual layer or add a label to contours to create a minor and 
major contour effect. 

See also “Layers” and “Annotations”. 
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